Canon Macintosh

Image Viewing, Organizing and Editing Software

ImageBrowser
Ver. 6.7
Instruction Manual

In this manual, IB is used for ImageBrowser.

Click on the icons below on the bottom right of the screen to switch
between pages.

@ . Go to next page @ . Go to previous page
. Return to a page you had previously displayed

Click on the chapter headings on the right side of the screen to switch to
the contents page of each chapter.
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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON'’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction

Main Features of IB

Download images to your computer
Check images

Print images

Organize images

Edit images
Adjust images
Trim images
Insert text
Correct red-eye
Change image size and type

Utilize images
Attach an image to an e-mail
Create wallpaper or a screen saver

Convert images
Change image size and type

Play Movies
Use your images with CANON iMAGE GATEWAY
Sym bols Used

: Selection procedure for menus that appear on the computer
screen
[ ] :Names of items and menus, buttons, windows, etc. that appear on
the computer screen
: Camera switch name or icon, or a keyboard key name
: Reference page (jump to page by clicking)

< >
p.**
"2 :Help 2@ Tip

: Important information |§| : Helpful information

Makeup of Each Chapter

Chapter 1 Basic Operation
Starting up and quitting 1B
Downloading images to your computer
Checking images
Playing movies
Printing images

Chapter 2 Advanced Operation

Efficient checking of images
Organizing images

@ Editing images

® Editing movies

© Utilizing images

©® Index printing

) Layout printing

Chapter 3 High-Level Functions
Checking images with high-level functions
Organizing images with high-level functions
Advanced image editing

Chapter 4 Preferences
Settings for all functions

Chapter 5 Using Images on the Internet
Using CANON iIMAGE GATEWAY

Reference
Solving problems

Uninstalling IB

System requirements

Supported images

Lists of primary window functions
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Starting up IB

Click the icon on the Dock.

ImageBrowser

Click

A 4

Main window (browser window)

@ imegeliomser [ih LS Yeem imiersen Window flein - o
ana [ —

Downloading an Image to Your Computer

Connect the camera and computer with the cable provided and

download the images saved on the memory card inserted in the camera.

For downloading images, start up the camera software “EOS Utility” and
use.

Connect your camera and computer and turn the
camera on.
When IB starts up, connect the camera and your computer with the
interface cable provided with the camera and turn the camera on.
For detailed instructions on connecting your camera and
computer, refer to the “EOS Ultility Instruction Manual” (PDF
electronic manual).

EOS Utility starts up automatically.
EOS Utility

Yala) EOS Utility - EOS XXX

Control Camera Accessories

Starts to download images

Lets you select and download images

Camera settings/Remote shooting

Monitor Folder
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Download images.

enn EOS Utility — EOS XXX

Control Camera Accessories

Starts to download images CI|Ck

Lets you select and download images

Camera settings /Remote shooting

Monitor Folder

Downloading of images begins.

The downloaded images are saved in the [Pictures] folder and
are displayed in the main window of IB.

The downloaded images are sorted into folders by date and
saved.

Click the EOS Utility [Quit] button to quit EOS Ultility and turn the
camera’s power switch to < OFF >,

i@/i- Advantages of using EOS Utility to download images

Using EOS Utility to download images makes it easier to organize your
images as they are downloaded, sorted and saved into folders by date.

Downloading Images Using Your Card Reader

You can also download images to the computer using a third-party card

reader.

Start up IB and then select the save destination for
the images in the folder area at the left of the main

window.

(606

Images acquired from your camera
can be accessed here.

Favorite Folders | Al Folders

].

?TEMécinmEh HD \
| A Applications
[¥ Photo
Y& Users
¥ {1 canon
»EE Desktop
b Documents
[ Movies

»{ " Shared

—— Click

Load the memory card into the card reader.

Download images window appears.
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Download images.
Download images window

fie

ImageBrowser Canon

[ Download Images ] Click

Lets you select and
| download images

[ Print Menu ]

Preferences... Exit

Downloading of images begins.

The downloaded images are saved in the folder selected in step
1 and are displayed in the main window of IB.

The downloaded images are sorted into folders by date and
saved.

Click the [EXxit] button to quit Download images window.

-2\@/3 Advantages of using IB to download images

Using IB to download images makes it easier to organize your images
as they are downloaded, sorted and saved into folders by date.

® Depending on the card reader and computer OS used, SDXC cards
might not be correctly detected. In such a case, connect your
camera and computer with the provided interface cable, and
transfer the images to your computer.

Viewing an Image

Images and movies downloaded to your computer are displayed as
thumbnail images in the main window. You can double-click a thumbnail
to open the viewer window and display an image at a larger size or play
a movie.

Main window

ks

Images acquired from your camera.
can be accessed here.

Modified XK/ XX /XX

7 Keyword

T ———
( View/Modify Keywords... )

¥ Brightness Histogram

IMG_000LJPG IMG_0002,JPG IMG_0003JPG IMG_0004 JPG IMG_0005 JPG J

5 | ——— & & scammad -] =33
e ) = @ V. . -]
[ ada. | remowe Canon Camerz— View Image Sideshow CANON MAGE  Printa&share | Sendto Trash
ATEAY

Click to select the image | The clicked image is enlarged and
displayed in the center of the window

Displays the images in the folder that was selected
from the folder area on the left of the window
To select multiple images, click on the images while holding
down the < 38 > key or < shift > key on the keyboard.
You can select all images in a folder by clicking the [Selecting
Images] button and then selecting [Select All] from the menu that
appears.
When you have selected a movie, the first frame shot is
displayed in the center. For playing movies, refer to p.13.

@ For a list of main window functions, refer to p.77.
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View Images as Thumbnails in the Main Window

You can change the display mode of the main window to show only a list
of the thumbnail images.

Click the [List Mode] tab sheet.

=8]8 view nternet WINGoW Aeip

| | Browser

bur camera E Preview Mode l| List Mode ]'

Click
The main window display changes to List Mode.

Main window (List Mode)

AN

IMAGRE ACGUR BOM YT CAME
£80 B ASSAIRAS A,

TE 3005IFC.

TV BO10UPC

View (I e i R S S T 3=
e ) L 2 ?. B, 0B
N Mﬂ= kmi_ Caron Camera View Image SideStow Ll:‘ﬂ\ml:‘fl Print &4 Share Send to Teash
Click to select the image Displays the images in the folder

that was selected from the folder
area on the left of the window

To select multiple images, click on the images while holding
down the < 38 > key or < shift > key on the keyboard.

You can select all images in a folder by clicking the [Selecting
Images] button and then selecting [Select All] from the menu that
appears.

@ For a list of List Mode functions, refer to p.78.
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Changing the Display Magnification
You can change the display magnification of the thumbnail images
displayed in Preview Mode (p.77) and List Mode (p.78).

Change the display magnification.

—

i = £ V. e

Canon Camera View Image SlideShpw CANON IMAGE Print && Share S
CATEWAY

Drag left or right

© You can also change the display magnification by clicking [ &, ]
or[ & 1.
-» The display magnification of the images changes.

Enlarging and Viewing Images One at a Time

Double-click an image to enlarge.
Double-click

B yout Camers

red
accessed here,

Fobders | All Fulders

13 Marvies
it Picrures
L4 iPhoto Libeary

vl x:

TWC 3001 T

~.

Foreiites

[ e

=» The viewer window appears.

NG 2004 PG

MG 2009 PG

WC 090517

MG 030G

" RIC_0314 R

G
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Introduction

Click [ 4] or [ ] to switch to the image you want to Displaying an Image Across the Whole
display. Window (Full View Display) Table of

; ; Contents
Viewer window Double-click on the image you want to display

IMC_0001JPC (1/16)
across the whole window.
Advanced
Operation
High-Level
Functions
4 _ii > = 2 Preferences
(Frovrio Wwwwwis _g @ You can also display the image across the whole window by
g ‘ # &6 = H 3 = 4 clicking [ 2 1 (Full Screen) on the bottom of the window. Usingsthe
T SR =» The image is enlarged and displayed across the whole window. Internet
The shooting information is displayed if you click [ <2 ] (Show
Shooting Information) and select [Show Shooting Information]
from the menu that appears. Reference
To quit the viewer window, click [ €3 ] on the top left of the
window.
Contents
Lookup
? When you display RAW images in the viewer window
In the viewer window, the JPEG embedded in the RAW image is Index

-

QO

To return to the viewer window, click on the window or press the @
12

displayed instead of the actual RAW image. In some cases, displayed
images may be grainy.

To check the actual RAW image, use the bundled software Digital Photo
Professional.

@ For a list of viewer window functions, refer to p.79. < esc > key on the keyboard.



Playing Movies

You can play movies and Video Snapshot Albums that you have shot.
Movie files are marked with the [ *#® ] icon and Video Snapshot Albums
with the [E&] icon in the thumbnail image frame in the main window.

In the main window, double-click a movie (image

marked with the [*= ] icon) or a Video Snapshot

Album (image marked with the [E&;] icon).
Double-click

G

an 1o Boceseed hass

A viewer window appears.

Click the [ » ] button.

ape B MV10O00.MOV (1/17)
e -
w -
‘ : /
e .---gﬁ? ==
o :
( Save as Stil Image... Cut Movie...
Fit 1o window B v
4 | 2 ! A . 35 - ) =3 L
Btk Ll S tae Namber of Onplayt  Symchronoe Tl Screen B how
Infarmatios n
Movie Lan G0 w 480 Daslay 107 %

» The movie begins to play.
@ Playback stops automatically when the movie ends.
©® To play the same movie again, click the [ ¥ ] button.
@ You can save the currently displayed scene as a still image by
clicking the [Save as Still Image] button.
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Rewriting Images to a Memory Card

You can rewrite images and MOV movies that you have saved on a
computer to a memory card and then play them back on the camera.
Use a third-party card reader to rewrite your images or movies to a

memory card.

Insert a memory card that has been formatted on the

camera into the card reader.

Select the image or movie you want to rewrite.

e S e B

[B imepsbeomr Tie UiV _inrori_Woden e

Rewrite the image or movie.

Select the [File] menu » [Rewrite Image to Memory Card].

Open... 0
Close W
Save 185
Save As... 4aes
New Folder 8N
Favorite Folders >
Cet Info... o
Copy Image...

Move Image...

Duplicate %0
Rename...

Send to Trash %8 &
Search... seF
Export Image...

Organize Image 4

Process RAW Images by Digital Photo Professional...
Processing RAW/Image...

Connect to Camera...
Rewrite Image to Memory Card... ]

Print >

Sound
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Select the destination memory card and click the

Printing an Image

This section explains how to print one image on one sheet of paper.

[OK] button.
(600

ImageBrowser

Select Memory Card

EOS_DIGITAL

Cancel . f—'ﬁ&—)

A confirmation window appears.

Click the [Transfer] button in the confirmation

window.

Image or movie exporting begins.

® You cannot rewrite MOV movies that have undergone movie

editing (p.34) to a memory card.

AVI movies cannot be rewritten to a memory card.

Select the image to be printed.

Click

@ To select multiple images, click on the images while holding
down the < 38 > key or < shift > key on the keyboard.

@ You can select all images in a folder by clicking the [Selecting
Images] button and then selecting [Select All] from the menu that

appears.

Display the print settings window.
Click the [Print & Share] button and then select [Photo Print] from

the menu that appears.

Q| Selecting Images  * =3 =

.

Print && Share

]

Send to Trash

The [Photo Print] window appears.

. &
\GE Print && Share Send to Trash
f

Layout Print...
Create Image for Email...
Upload movies to YouTube...

Photo Print... lo. of Images
ndex Frint... F -

)
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Set the paper size and other settings, and then click

the [Print] button.
Photo Print window

(@06 Photo Print

Printer

Canon XXX }--H

Page setup...

Paper size :
Ad

Click [Page Setup] to enable
borderless printing on
supported printers.

Shooting Date/Time

| None }-H

Properties

wl Remove unwanted regions it
==* | of your photo. L &__.

Add some text to print
with this photo.

EE Image: 1/1 Copies:

Total :

1 pages

(¢

Print

),

Printing begins.

@ When printing RAW images, the JPEG embedded in the RAW

image is printed instead of the actual RAW image. In some cases,

printed images may be grainy.

|§| For a list of photo print window functions, refer to p.82.

Quitting 1B

In the main window, select the [ImageBrowser] menu

» [Quit ImageBrowser].

ImageBrowser

About ImageBrowser...
Preferences... 38,
Service b
Hide ImageBrowser 3H

ide Others L#EH

Snow

(Quitlmageﬁrowser ®0

IB quits.

)
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Checking/Sorting Images introduction

You can enlarge images one at a time from a list in the main window, Click [ 4] or [ ] to switch to the image you want to

check what they look like in detail, and sort them with ratings. display. S
Viewer window Contents
(oo &IMG.0001JPG(1/16)

Enlarging and Checking Images One at a Time

Double-click on the image on the top left of the main
window.
Double-click

Basic
Operation

Adv ed
Op ion

High-Level
Functions
Preferences
I_ B Fit to window B Vrseve ey
!::k N:t ‘ ;;i Ei T Numheﬂl;lays mi\f;-ize Ful%‘ean :;m‘ shguw " USIng the
Image Size: 3888 x 2592 | ‘ Ifnm::ip:v- 19 % Internet
© The shooting information is displayed if you click [ =2 ] (Show
Shooting Information) and select [Show Shooting Information]
e from the menu that appears. Reference
The viewer window appears. To quit the viewer window, click [ £ ] on the top left of the
window.
When a RAW image is displayed in the viewer window, the JPEG Contents
embedded in the RAW image is displayed instead of the actual Lockup
RAW image. In some cases, displayed images may be grainy. To
check the actual RAW image, use the bundled software Digital
Photo Professional. Index
-3@/3 To display only selected images in the viewer window
Select multiple images in the main window (p.10) and then click on @ @
[@H (View Image) (p.78) on the bottom of the main window to display
only the selected images in the viewer window. @

ﬁl For a list of viewer window functions, refer to p.79. 18



Enlarging a Specific Part of an Image

Enlarge an image.
Click the list box and then select the display magnification.

+ Fit to window
200%
175%

Fit to window [ 3] KRN ¢ 150% Par
125%

G = B | 100
- hd =1 —_ 75% ]

Save Edit MNumber of Displays Synchroni: Save 50% bys  Synchroni

25%

The image enlarges and the navigator window appears.
RAW images cannot be enlarged.

Display the part of the image you want to check.
Drag the enlargement display position in the navigator window
and display the part of the image you want to check.
Navigator window

200 - SR NCSLECRUS S

Enlargement
display position
Drag to move the
display position

Display magnification

To return to full view, select [Fit to window] from the list box.

Sorting Images

You can sort images into one of seven groups by setting ratings
according to the photo subject or a theme.
Ratings can be set from the following seven types.

. (none), [e], [l [ LI 11 I?
[Reject]

)

Introduction

Table of
Contents

Basic
Operation

Increase or decrease [ .¢].

— Click to increase

= .o E = .- .
Number of Displays Synchronize Full Screen Prir| CIICk to decrease

©® [Reject] cannot be set in the viewer window. Set [Reject] in the
main window.

|§| © You can display and change rating settings set in IB version 6.6 or
later with other bundled software or on an EOS 60D, EOS REBEL
T3i/600D, or EOS REBEL T3/1100D camera.
« EOS Utility version 2.9 or later:
Ratings set in IB version 6.6 or later are displayed on image
thumbnails in the viewer window. However, [Reject] is not
displayed and you cannot change rating settings.
« Digital Photo Professional version 3.9 or later:
Ratings set for still images in IB version 6.6 or later are
displayed on image thumbnails in the main window, etc. You
can also change rating settings.
* On an EOS 60D, EOS REBEL T3i/600D, or EOS REBEL T3/
1100D camera:
Ratings set in IB version 6.6 or later are displayed in the
playback screen. You can also change rating settings. However,
you cannot display or change settings for [Reject].
Reversely, you can also display and change with IB version 6.6 or
later the rating settings set for still images in Digital Photo
Professional version 3.9 or later or on an EOS 60D, EOS REBEL
T3i/600D, or EOS REBEL T3/1100D camera.
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Sorting Images in the Main Window

Select images in the main window, and then select
the [Edit] menu P> [Change Rating] P> select the

setting.

_

Select All A
Deselect All

Rotate Image...
Rotate According to Rotation Information

Movie Edit...
Edit EOS Video snapshot...
Extract frames from a movie...

PhotoStitch...

Edit with Registered Application >
Keyword >
Special Characters... BT

You can also click on a thumbnail image in the main window
while holding down the <control> key on the keyboard, and then
from the menu that appears select [Change Rating] P select the

setting.

Reject

Filtering Images You Want to Display

You can filter images displayed in the main window by the ratings you
have attached to them.

Click the [ ] button.
View [ﬁ? Alter Toal '),_{\_. a, 9 Selacting Images ‘. g
ol == Al (= - I B
5 = = . . 3
Canon Camera View Image SlideShow CANON IMAGE Print && Share Send to Tras|
CATEWAY

The filter function appears.

Set the criteria to filter images.

d
Filter by Rating: ( All & | Greater than 7 ]
gaz A i | 7 | = E
View I;v\! Filter Tool ‘—I —_— 2, @ Slecting Images 4 4
il - Al - - ! 8
X6 = = = -
Canon Camera View Image Slideshow CANOM IMAGE Print && Share Send to Tras|
» 4 GATEWAY

+ Only the images with the criteria you have set are displayed in
the main window.
To quit the filter display, click the [ ] button again
and then select [Select All].

@ To users of ImageBrowser ver. 6.5 and earlier
The method for setting ratings has greatly changed starting with ver.
6.6.

Accordingly, a rating may be displayed differently even for the same

image between ver. 6.6 or later and ver. 6.5 and earlier.

For detailed information, refer to the Help for ImageBrowser ver. 6.6

or later.
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Arranging Images in the Main Window
You can arrange images in the order of file size or shot date and time.

Select the [View] menu P> [Sort] P> desired item.

Refresh

View Mode 2
View Settings b

0 v File Name

) File Modification Date
Display » | Filesize
Enlarge %+ Shooting Date/Time
Reduce a6 — Type
View Actual Image v Ascending

Descending

Slide Show...
Slide Show Options...

R

The images are arranged in the order according to the selected

item.

Sort item
File Name

File Modification
Date

File Size

Shooting
Date/Time

Type

Ascending

Descending

Description
Image file names are arranged in the order of 0 -9 - a - z.

Images are arranged in the order of most recently
updated.

Images are arranged in the order of the smallest file size.

Images are arranged in the order of most recently shot.

Images are arranged in the order of BMP images > RAW
images = JPEG images = MOV movies - PICT images
- TIFF images.

Images are arranged from top to bottom in order of
sorting criteria.

Images are arranged from bottom to top in order of
sorting criteria.

Efficiently Checking/Sorting Images

With the Preview Mode that displays images as thumbnails and single
images in the same window, you can efficiently check the images. You
can also check the images’ shooting information or sort them by setting
their ratings.

Enable Preview Mode.

File Edit View Internet Window Help

bur camera l Preview Mode l List Mode

Click
The main window display switches to Preview Mode.

[ | Browser
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Org aanlng Imag es Introduction

This section explains functions that are useful for organizing images
such as creating new folders for saving sorted images, moving and

Click on athumbnail image to switch to the image
you want to check, and then sort by setting ratings.

copying images and deleting unwanted images Table of
Click to increase or decrease Pying g 9 ges. Contents
Preview Mod
‘ Creating a Folder for Saving Images Basic
T e — Operation

Modified: XXXX/ XX XX

™8
Image Siz: 3888 x 2592
Data Typ PG

You can create a folder to save sorted images.

‘ In the folder area, select the location where the new Ad\@ed
folder is to be created. Opglion
(@06
e Images acquired from your camera High-Level
——— can be accessed here. Functions
| Favorite Folders | All Folders ] Preferences
v Macintosh HD ]
» 4 Applications
IMC_0001 PG IMC_0002JPG IMC_0003,°C 7{»&@%»4% IMC_0005.4PC ety Ph USIng the
= e g TR ‘L‘ USE: Internet
& |= 4 @, Bl 8 i e
| e |[ remoe | Comom o | e O e weeens =AY w4 canon
Thumbnail image The selected image in the thumbnail ST Documents
. . ; . . L Reference
display area image display area is enlarged in the [@ Movies
center of the window
When a RAW image is displayed, the JPEG embedded in the {2 shared c
: S ) X ontents
RAW image is displayed instead of the actual RAW image. In Lookup
some cases, displayed images may be grainy. To check the actual
RAW image, use the bundled software Digital Photo Professional.
When you have selected a movie, the first frame shot is ind
displayed in the center. For playing movies, refer to p.13. naex
To set [Reject] for ratings, select the [Edit] menu P [Change -

Rating] P [Reject], or click on a thumbnail image while holding
down the <control> key on the keyboard and then select [Change
Rating] > [Reject] from the menu that appears.

|§| For a list of Preview Mode functions, refer to p.77.

QO
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Select the [File] menu P> [New Folder].
| File |

Open #0
Close ®W

#£S

Save As

' New Folder %N)
5 >

Cet Info... £

Copy Image...

Move Image...

Duplicate ®D
Rename...

Send to Trash @

Search... 8F

Export Image...

Organize Image >
Process RAW Images by Digital Photo Professional...
Processing RAW Image...

Connect to Camera...
Rewrite Image to Memory Card...

Print »

Sound

The [New Folder] window appeatrs.

Enter a folder name and click the [OK] button.
The new folder is created in the folder selected in step 1.

Moving Images

)

Introduction

. . Table of
You can move or copy images to separate folders and organize them Contents
according to shot date or theme.
Drag the image to be moved or copied. Basic
Operation

To move:Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the < option > key

and release when the image is in the destination folder.

-
8n0e
Images acquired from your camera ( Preview Mode [ ListMode |

can be accessed here.

| Favorite Folders F—W
y A=

| w3 Macintosh HD
» & Applications
¥l Users
v @ canon
b Desktgp
| »| " Docujnents
[ Moviks
LELT
[ iPhoto Library
Wi OUK KX XX
[ xxonx_xx_01
[77 soexx_xx_02
[,- wxxx_xx_03
3 xxxx_xx_04

IMG_OD0L JPG

IMG_0006 PG

-

The image is moved or copied to the folder it was dragged to.
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Moving Images in Folders

You can move or copy folders that contain images, and organize images
in folders.

Drag the folder to be moved or copied.
To move:Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the < option > key
and release when the folder is in the destination folder.

(@00

Images acquired from your camera | Preview Made | List Mode
can be accessed here.

)

| Favorite Folders | Al Folders |

¥=) Macintosh HD
P & Applications
¥|.L Users
w i canon
- Desktop
|\ Documents
[Sl Movies
vfg Pictures
[ iPhoto Library
[Z Photo
WA ok _xx_Xx
2 ooxx_xx_02
[ xxxx_xx_03
[ xxxx_xx_04

IMG_0001.JPG

IMC_0008.|PG

N
der it was dragged to.

The folder is moved or copied to the fol

Changing File and Folder Names for Images

In the main window, select the image whose name

you want to change, or, in the folder area, select the

folder whose name you want to change.

Select the [File] menu P [Rename].

Save As...

New Folder #N
Favorite Folders >

Get Infa... £

Copy Image...
Move Image...

o A
Rename... !
N Lo Irasn

Search... ®F

Export Image...

Organize Image »
Process RAW Images by Digital Photo Professional...
Processing RAW lmage...

Connect to Camera...
Rewrite Image to Memory Card...

Print »

Sound

The [Rename] window appears.

)
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Enter the file or folder name of the image and then

click the [OK] button.
Rename window

-

Rename

File Name]

Photo

Cancel

(€

oK

)

The file or folder name changes to the new one.

You can also change the file name in the [File Information]
window (p.52) or in the information display area (p.77) in Preview

Mode.

You can also change the folder name in the [File Information]

window (p.52).

Deleting an Image or Folder

Deleted images and folders cannot be recovered. Also, take care when
deleting folders as all the images inside a folder will also be deleted.

In the main window, select the image you want to
delete, or in the folder area, select the folder you
want to delete.

Click [Send to Trash].

— Q QIL_SEIEC“"E""WES 'I EI .ﬂ -
% - % - g

RNOM IMAGE Print && Share Send to Trash
GATEWAY

=» The image or folder is moved to the [Trash] and is deleted from
IB.

@ If the [Move to Trash?] dialog box appears, click the [Yes] button.

To delete an image or a folder from your computer, on the
desktop, select the [Finder] menu P [Empty Trash].
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Registering Frequently-Used Folders as Favorite Folders

You can register shortcuts for frequently-used folders in the [Favorite
Folders] tab sheet in the folder area to make images easier to find.
Please note that because the [Pictures] folder is registered as a favorite
folder by default, the folder icon appears as [ | ].

Select the folder you want to register.

Images acquired from your camera
can be accessed here.

Favorite Folders | All Folders ]

¥_=i Macintosh HD
B-| M Applications
¥k Users
¥ % canon

b % Documents
[E Movies
[ Pictures

E——————— )

| Add to Favorites |

Click the [Add to Favorites] button.

The folder icon changes to [__~;£ ] and the folder is registered as a
favorite folder.

Select the [Favorite Folders] tab sheet.

Select the registered folder to display the images
inside the folder.

Images acquired from your camera
can be accessed here.

[-anri{e-FnIdm = All Folders

= Pictures

3

Favorites

Add... ‘ | Remove

The images inside the folder appear.

? If you have edited or deleted images in folders you have
registered as favorites

Any changes done to images inside registered folders will be applied to
the original images. Therefore, please be aware that by editing or
deleting images inside registered folders, you are in fact editing or
deleting the original images.

)
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Deleting Favorite Folders

If you no longer need a folder you have registered in the [Favorite
Folders] tab sheet, you can delete it from this tab sheet.

Please note that as registered folders are shortcuts, the original folder
will not be deleted when you delete the shortcut.

In the [Favorite Folders] tab sheet, select the folder
you want to delete and then click the [Remove]
button.

Images acquired from your camera
can be accessed here.

[ Favorite Folders | All Folders

B Mavie
B2 Pictures

™

.
&

v

Favorites

Add... | ‘ Remove

The folder is deleted.

Editing an Image

If the brightness or color of images is different from what you visualized
when you shot the photo, you can adjust an image using the editing
functions to bring them closer to what you visualized.

This section explains about automatic adjustment of images, adjustment
of brightness/saturation, trimming images, inserting text into images,
adjustment of sharpness, red-eye correction, and cutting movies.

JPEG images deteriorate slightly when edited and saved, and the image
before editing cannot be recovered. For this reason, an edited JPEG
image should be saved as a separate image from the original image.
Chapter 3 explains about high-level editing functions other than those
described above.

|§| You can edit RAW images in Digital Photo Professional (hereinafter,
“DPP”). Select the RAW image in the Main Window and select the
[File] menu P [Process RAW Images by Digital Photo Professional],
which will start up DPP. For detailed instructions on using DPP, refer
to “Digital Photo Professional Instruction Manual” (PDF electronic
manual).

Automatic Adjustment Using IB
The brightness and colors, etc. of the image are automatically adjusted.

Display the image to edit in the viewer window (p.18).

Click [Edit] and then select [Auto Adjustment] in the
menu that appears.

Trim...

Color/Brightness Adjustment...
Red Eye Correction...

Insert Text...

Level Adjustment...

Tone Curve Adjustment...
Sharpness...

( Auto Adjustment... )

Fi ind e B e AN g aripged . o
M‘ e —‘ Edit with Registered Application »
a.] =. g QG e :

Edit MNumber of Displays Synchronize Full Scree Edit Mumber of Displays  Synchronize Full

The [Auto Adjustment] window appears.
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Click the [Auto Adjust Image] button.
Auto Adjustment window

Auto Adjustment

(L Auto Adjust Image J

Undo

| Show Original Image

T
§ Cancel

OK

Display Size 3888 % 2502 | |

The image is adjusted.

Check the adjustments.

__! Show Original Image

Display Size: 3888 % 2502

Checkmark to display the image before adjustments

Click the [OK] button.
The [Auto Adjustment] window closes.

Save as a separate image.
In the viewer window, click [Save].

Fit to window B (A
< » |l &a| @ Gl

o Number of
Back Next Save Edit Displays Synchrao|

3888 x 2592 |

The save dialog box appeatrs.

Enter a new name, specify the save location and then
click the [Save] button.
Enter the new name  Specify the save location

06060 & IMG_0001 JPG (1/16)

Save As: | IMG_0001 ™

Where: | [l Desktop 3]
Image Type: | Exif JPEG B3]
.
o ” 2

Fit to window [ P e O o
&5 == =1 my %
4 4 & &. =H. # = =3 Q.
Back Next Save it Numberof Displays Synchronize  Full Screen print Show

Infarmation

)
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Image Size: 3888 x 2592 | ‘ Display: 19 %

The edited image is saved as a separate image from the original
image.
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Introduction
Adjusting Color and Brightness Trimming an Image
You can adjust the brightness and color (saturation) of images. You can trim only the part of an image you need, or change the ggﬁt'gn"tfs
composition of an image where an image shot horizontally becomes
Display the image to edit in the viewer window (p.18). vertical.
Basic
. . . i i iti i i Operation
Click [Edit] and then select [Color/Brightness Display the image to edit in the viewer window (p.18).

Adjustment] in the menu that appears (p.27).

The [Color/Brightness Adjustment] window appears. Click [Edit] and then select [Trim Image] in the menu Ad\aced

that appears (p.27). Opggetion

Select the [Color Adjustment] tab sheet and adjust The [Trim Image] window appears.

the image. D he tri i High-Level
Color/Brightness Adjustment window rag p rlmmlng range. Functions
Color/Brightness Adjustment Trl m Im ag ewin d ow
[ Trim Image
! rRGB Adjus[mentll Color Adjustment !’—
. - ;}:;;n;g:t\:ir:: I;eo::-rimmed to the area shown Preferen ces
Saturation 5 0 i
1. Move and resize the trim box in the
Brightness 6 0 ) preview area. .
- B Using the
(. Advanced Options ) Internet
N 2. Click Trim Image to apply the settings.
Undo All Undo Redo N ) = | Reference
( Cancel ) (—e;e—) : E— 2
Undo Redo
D t th I ft H ht t d t L = 3 ] Q‘ 3. Click OK to close the panel. Contents
rag to the left or right to adjus Fit to window o S Lookup
Move the slider to the right to make the [Saturation] of an image ) =
to appear more vivid and the [Brightness] appear brighter. Move Diplay Sze: 3888 x 2582 [ xm  vas  woan w am [zoommato 10v
the slider to the left to make the [Saturation] of an image weaker, Index
and the [Brightness] of an image appears darker. Drag
The image is adjusted. The trimming range can be moved by dragging.
Check the adjustments and then click the [OK] You can change the trimming range by dragging the four corners @ @
button. and the four sides of the trimming range. @

Save the image as a separate image (p.28).
29
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Click the [Trim Image] button. Inserting Text into Images

ick Tri i . , , , Table of
SRR B e You can insert the date and time you shot an image and text into an Contents

image as text.

[C Trim Image )]

Undo Redo Display the image to edit in the viewer window (p.18). Basic
Operation
3. Click OK to close the panel. Click [Edit] and then select [Insert Text] in the menu
The image is trimmed. that appears (p.27). é%@cigﬁ
The [Insert Text] window appears.

Check the trimming and then click the [OK] button.

Drag the range for inserting text. _
. . Insert Text window aloh ol
Save the image as a separate image (p.28). . S— Functions
FontName:  (Genea )
Font Size: 72
TextColor: | Preferences
Text B
@Amialias
ext; Using the
Internet
[ & Import Shooting Date/Time ;l
S (Frmvidor 18 @ & Reference
Undo All Undo Redo
( Cancel ) L oK :J Contents
Display Size: 3888 x 2592 [ Dpisplay: 9% LO 0 ku p
Drag
The text insertion range can be moved by dragging. Index
You can change the text insertion range by dragging the four

corners and the four sides of the text insertion range. —_—

QO
O
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Using the keyboard, enter the text you want to insert.

EAntiaIias

;I'mtr' -~
Import Comment

( Import Shooting Date/Time )

The text you enter appears in the window.

Check your entry and then click the [OK] button.

Save the image as a separate image (p.28).

Adjusting Sharpness

You can make the overall atmosphere of an image harder or softer.

Display the image to edit in the viewer window (p.18).

Click [Edit] and then select [Sharpness] in the menu

that appears (p.27).
The [Sharpness] window appears.

Adjust the image.
Sharpness window

)
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Sharpness

Undo All Undo Redo

¢ Cancel )G—H

Display Size: 3838 x 2592

Drag right to adjust

Move the slider to the right to make an image harder and to the
left to make an image softer.
The image is adjusted.
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Check the adjustments and then click the [OK]
button.

Save the image as a separate image (p.28).

Correcting Red-Eye Automatically

You can automatically detect and correct red-eye that occurs when you
photograph people using a flash.

Display the image to edit in the viewer window (p.18).

Click [Edit] and then select [Red Eye Correction] in

the menu that appears (p.27).
The [Red Eye Correction] window appeatrs.

Click the [Start] button.
Red Eye Correction window

YO8 Red Eye Correction
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The image is corrected.

Check the corrections and then click the [OK]
button.

Save the image as a separate image (p.28).
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Correcting Red-Eye Manually

You can manually correct red-eye that cannot be corrected
automatically.

1 Display the [Red Eye Correction] window (p.32).

2 Select [Manual Mode] and then enlarge the image.

Enlarge image display

3 Set the amount of correction.
eManua[ Mode

Weak & Strang Drag to the left or right to

' ! adjust
1 2 3

[Boe Red Eye Correction
| O Aute Mode Start
| ® Manual Mode
Weak + Sirong
1 2 3
Surround a red area to specify the area you want to correct
|
.
v
I mairl | [[37% e
[ stow Original Image  Undoan )| { Undo ) { Redo W)
__Caneel ) ¢ Ok
rHspiay Sire: 172R% 1152 [ mispiay X £

Drag and place a box around the place in the image
you want to correct and then click [OK].

[Boe Red Eye Correction
| O Aute Mode Start
| | ® Manual Mode
Weak + Strong
1 2 3
Surround a red area to specify the area you want to correet

| (7% B e
( uUndoan ) Undo ) | Redo
__Caneel ) ¢ Ok

[ Duspiay: it 4

Click [OK]

Drag a box on the place to correct
=» The image is corrected.

5 Correct other places in the same way.
6 Check the correction and click the [OK] button.

7 Save as a separate image (p.28).
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141 1 Introduction
Editing Movies
You can edit the movies you have downloaded to your computer in a Select the [Edit] menu P [Movie Edit].
number of ways, including joining movies together and adding special "Edt | Table of
effects such as titles and background music. TR == Contents
(D o when editing 1920 x 1080 MOV movies with a function other than i
“Cutting Movies” (p.38), a temporary file is created for editing and it ol
may take some time before you can start editing. Ope?zlt(i:on
Once you have edited movies using these functions, you cannot

play them back on the camera. Select All ®A

. . . Deselect All
You cannot edit MOV movies on a computer with a PowerPC Ad\aced
Rotate Image... 0] ion
CPU. Rotate According to Rotation Information P
Select the movie. _
epas—— e C— - - Functions
Edit still image
Movie Edit... |
kdit EOS Video snapshot... Preferences
Extract frames from a movie...
PhotoStitch...
Edit with Registered Application 2 .
Using the
Keyword > Internet
Change Rating »
Special Characters... T
The movie editing window appears. Reference
A —_—— A, . Fi ]
e I L T
Contents
Lookup
Index

-

® There is a limit on the number of files when you are editing MOV @ @

movies. When you edit 1920 x 1080 MOV movies and save them in

the same image type (format)/size, keep the number of files within

20 files. Similarly, for 1280 x 720 and 640 x 480 MOV movies, keep @
it around 25 files.
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Click the tab to select an editing task, and then edit
the movie.

Select the editing task Guidance

8606 Movietdit Task ‘

Arrange images.
1. To arrange images, select the image and click on the [Move Left] or [Move Right] button.
2. Click the [Play] button to play the arranged effects and check them.

3. Click the [Effect] tab to go to Effect Step.

2 Effect 3. Audio 4.Save

w—
Lz @ s BH(R OR|NE
Add Image Play Time Rotate Move Left Mave Right Properties Clear Enlarge Reduce

— B

LArrange

L

Play

Total Time 2:10.0

Enlarges/reduces movie

Movie icon thumbnails

Storyboard area* Shows detailed instructions

Transition box (icon for the special effect used in
the transition between joined movies)

* Selected movies are shown as thumbnails. Movies are joined
together sequentially starting from the leftmost movie.

[Arrange] tab sheet functions
Set the playback range for the movie (playback start and end)*
Set rotation or mirroring for the selected movie

Play movies Rearrange the order of the selected movies

~

(e oe MavieEdit Task

Arrange images.
|1. To afrange imaggs, select the image [and click on the [Move Left] or [Move Right] button.
2. Click|the [Play] blitton to play the arringed effects and check them.

3. Click|the [Effect] jtab to go to Effect Sjep.

b le BIRXR O RI|IQ@

Play Add Image  Play Time Rotate | Mave Left  Move Right ) Properties Clear Enlarge Reduce

Total Time 2:10.0

_ Remove the selected
Adds movies to the movie from the storyboard
storyboard area area

Show information for the selected movie

* When a still image is selected in the storyboard area, you can
select the display period for the still image.

|§| When you add to the storyboard area an image with recorded audio

that has been shot with a EOS-1D series camera, the audio is not
automatically attached. Add the audio file in the [Audio] tab sheet on
the next page.

)
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Introduction
[Effect] tab sheet functions [Audio] tab sheet functions
Add text to the selected ~ Set the effect used in the transition Add an audio file to the selected movie* Table of
movie between movies (transition box)* AR T \ Contents
Add an audio effect.
Use the following steps to add an audio effect to an image. If an audio effect is unnecessary or you have m
@oe ‘ | e R e .
8 " Apply effects to image. 2. When you want to arrange the audio clips, select the audio clips you want to arrange and click the [Move Baslc
a \m P Ygs :an apply eﬁectg to an imagle using the steps shown below. When it is unnecessary to apply effects to an m Lable st e BlOR L ARt SRR G AIRATY O erat|0 n
m— g Limage or you have finished applying effects, click the [Audio] tab and proceed to the Audio step. p
1. Apply a Text effect or Filter effect to an image. Select the image you want to apply the effect to, click the 1. Arrange 2,Effect 3.Audio 4.5ave
e A S e e e T - . =
\nnhe 3 Tranci K Y i I> A, J \2 @ Q Q ‘ @
1. Arrange 2.Effect 3.Audio 4.5ave Play Add Audio  Advanced Move Left  Move Right  Properties Clear Enlarge Reduce Ad \V ed
> @ @ @ B E!‘ Qg ‘ ©) Opegétion
Play Text Effuct | Fiter Effeet’ |Magnilysec Transition) Froperties Clear ERlatar Redute s ’ o —
L]
: High-Level
Functions
Total Time 2:10.0
Adjust the audio volume for the selected movie and set Preferences
ol 2 ' “Fade-in” (gradually increasing volume) and “Fade-out”
_ (gradually decreasing volume)
Enlarge part of the selected movie o _ _
Convert the selected movie to sepia tone or monochrome *You can add an MP3, AIFF or WAV audio file as background music L{smg the
P (BGM) or as an effects tone. When you add audio to a movie in this el
* Select the transition box in the storyboard area and then click window, a bar showing the duration of the audio file appears under
[Transition] to set the effect used. the movie’s thumbnail in the storyboard area.
Reference
Click the [Save] tab sheet.
WAL LU a1 ayE UIE auuiu LIPS, SEIELL UIE auuiu Lips y
o Bioktl hutton to arranoo rthona
Contents
Lookup
= E =)
Move Left Move Right Properties
Index
The [Save] tab sheet appeatrs.

-

QO
O
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Click [Save] and specify the required settings
(destination, etc.) in the window that appears. Then
click [Savel].

re 06 MovieEdit Task

Save the edit results.
Click [Save] button to save the edit results.

1 Arrange 2.Effect 3.Audic

Play Save

Save image type : — ) Auto-select

@® Specify a save image type
MOV (H.264) [#] ( Advanced Settings...

XXX fps
Hz, 16 bits, Monaural

Set the format of the saved movie
Automatically set the optimal size and frame rate for saved
movies

When an image type is selected in the [Specify a save image
type] list box, clicking the [Advanced Settings] button allows you
to specify the [Image Size], [Frame per Second]* and [Quality]
(sound quality) settings. The [Quality] (sound quality) sampling
frequency for edited MOV movies is fixed at 48 kHz.

* Frame rate : number of frames recorded per second

The edited movie is saved.

Select the [MovieEdit Task] menu P [Quit MovieEdit
Task].

About MovieEdit Task
Preferences... E

Services [ 2

Hide MovieEdit Task 3H
Hide Others N #H

Quit Moviekdit Task #Q

@ If you convert the frame rate of a movie after editing, some scenes
may not playback smoothly.

When [MOV (H.264)] is selected in the [Specify a save image
type] list box in the window in step 5, the movie durations that can
be saved are as shown below.

Movie durations that can be saved

magesie 25 f2p35.9/72%Tg7sf/ps* S e ps

1920 x 1080 Under 10 min. -

1280 x 720 Under 20 min. Under 10 min.
640 x 480 Under 30 min. Under 20 min.
320 x 240 Under 60 min. -

If you attempt to save a movie that is longer than the times shown
above, a message appears. When this happens, shorten the
movie or reduce the image size.

* The frame rates 23.976 fps, 29.97 fps and 59.94 fps are
respectively displayed as 24 fps, 30 fps and 60 fps in the
camera menu.

Saving movies may take some time. Saving movies takes a

particularly long time when [MOV (H.264)] is selected in the

[Specify a save image type] list box.

E.g.) Saving a 1-minute movie with an image size of 1920 x 1080
takes about 7 minutes depending on the system
requirements (p.76).

Time taken to save varies largely with factors including
computer performance and image size, and may take an
even longer time.
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Cutting Movies

You can cut any favorite scene from a movie you have shot.

Double-click the movie you want to play.
Double-click

The viewer window appears.
Click the [Cut Movie] button.

CIEEE) B MVLO0G0 MOV 3/17)

- Save as Stll Image... ( Cut Movie... )
Fit 10 window [ R o S ks
4 (3 : k. EH. = 2 i ~.

ek ot [T fde  Nomberof Daplyt Syachronge el Screen it Shew

Moie San. 640 x 480 Caslay. 107 %

The [Cut Movie] window appears.

Click the [ ® ] button.
Cut Movie window

re 00 Cut Movie

_——

{ — = »
10:00.0/0:06.0

Set Time: 0:06.0

{+ Cancel 3 Save

=» The movie begins to play.

A Drag [ § ] at the position you want to set as the start
point, and drag [ p ] at the position you want to set

as the end point.
The movie is cut.

)
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Click the [Save] button.

i b t 4
e =
0:03.6/0:06.0

Set Time: 0:02.4

(" Cancel .( Save )

The save dialog box appeatrs.

Specify the file name and save destination and then
click the [Save] button.

Save As: 'El

I

Where: | © Documents '1!

[ Cancel ) ( Save \}

The cut movie is saved as a separate movie from the original
movie.

Using the Video Snapshot Album Window

You can both play and edit Video Snapshot Albums that were shot on an
EOS DIGITAL camera and downloaded to your computer. Edition
functions include changing the order or deleting Video Snapshots and
adding background music to Video Snapshot Albums.

This function cannot be used to edit movies other than Video Snapshot
Albums.

Playing Video Snapshot Albums
Select an image (Video Snapshot Album) in the main

window.
Images with [ ] on the thumbnail are EOS Video Snapshot
Albums.

Select the [Edit] menu P> [Edit EOS Video snapshot].
| Edit |

Undo
Reot

Cut

Copy

+aste

Select All BA
Deselect All

Rotate Image...
Rotate According to Rotation Information

Movie Edit...

| Edit EOS Video snapshot... ||
Extract frames from a movie...
PhotoStitch...
Edit with Registered Application >
Keyword >
Change Rating >
Special Characters... NET

The Video Snapshot Album window appears.
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Click the [ ¥ ] button.

Opens another Video Snapshot
Displays detailed instructions

Displays Video Snapshot selected in
Thumbnail area

= KNI KACKRNOLMOY

Driginal mavie informati

Displays
Video
Snapshot
information

Adjusts
playback
volume

3 | Qriginal mowie sound

Thumbnail area
A Video Snapshot Album plays.

Editing Video Snapshot Albums
Changing the Order of Video Snapshots

Select a Video Snapshot in the Thumbnail area.
= M X

I [ Original movie sound

Click the [[#=]] or [[==]] button.

Clicking the [ [#=] ] button switches order with the left Video
Snapshot, clicking the [ [=&] ] button switches with the right Video
Snapshot.

© You can delete a Video Snapshot by selecting a Video Snapshot
and clicking the [ X ] button.
You can undo an edit by clicking the [0 ] button on the top left of
the window, and redo it by clicking the [ (3} ] button.
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Adding Background Music to Video Snapshot
Albums

Select [Choose music file] in the [ J7] list box in the
Thumbnail area.

J + Original movie sound

You can also display a dialog box for opening a music file by
clicking the [‘]":l ] button on the top left of the Video Snapshot
Album window.

A dialog box appears for opening a music file.

(When you display the dialog box for opening a music file, the
[EOS Sample Music] files open.)

Select a music file and click the [Open] button.
Music is added and the music file information is displayed.

®Nn SO X MOY

R o0 H ?

Music file
information

i N AN ad]

» When [Original movie sound)] is selected in the [ J3] list box in
step 1, music file information is not displayed.

@ Video Snapshot Albums that have been edited other than with this
function cannot be re-edited.

ﬁl Video Snapshot Albums edited with this function can be played on
EOS REBEL T3i/600D.
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Saving Edited Video Snapshot Albums

Click the [] button on the top left of the window.
eno

73 o c0¢ |H 2

The [Save As] window appears.

Specify a save destination, enter a filename, and
click the [Save] button.

Exiting the Video Snapshot Album Window

Select the [EOS Video Snapshot Task] menu P [Quit

EOS Video Snapshot Task].

" EOS Video Snapshot Task
About EOS Video Snapshot Task

Services b

Hide EOS Video Snapshot Task #H
Hide Others X 3#8H

(' Quit EOS Video Snapshot Task Q)

The Video Snapshot Album window exits.

Utilizing Your Images

You can view your images as a slide show, send them in an e-mail or
use them as wallpaper or screen savers for your computer.

Viewing Images as a Slide Show

You can display selected images in full screen and switch between them
as a slide show.

Select images.

Select the [View] menu P> [Slide Show Options].

View Mode 2
View Settings »
Sort b
Display 3
Enlarge 3+
Reduce £
s Actual
S [OW
[ Slide Show Options... )

Refresh %R

The [Slide Show Options] window appears.
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Set the play method and transition effect for the slide

show and then click the [OK] button.
Slide Show Options window

-

Slide Show Options

Play Method
#) Auto Play

Play Interval —~= IGac

1 1 1 1 1 1 1 1 1 1
) Control with Mouse or Keypad

[ Repeat Continuously

1 Hides buttons

Transition Effect

" (None) e !

ar

@' ( cancel )| oK

S

The [Slide Show Options] window closes.
Click [SlideShow].

Al % =l
‘”) - -
Camera View Image SlideShow Print && Share Print & Emai
GATEWAY

The Slide Show window appears and the slide show begins.

Slide Show window

Rating setting
Selects the image**

Prints the image*?
Switches to the first image

L IIEnds the slide show

Switches to the last
image

Switches to the previous image —

—— Switches to the next
image

Pauses the slide
show

*1 The image is selected. When the slide show ends and returns to
the main window, the image is displayed as being selected.

*2 The image is selected for printing. When the slide show ends and
returns to the main window, the print dialog box is displayed.

When all the images have been displayed, the Slide Show
window closes and returns to the main window.
To end the slide show half-way through, click [@ ]
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Sending an Image by E-Mail

You can attach a selected image to an e-mail and send it.
The attached image to be sent is a copy of the original image and
therefore the original image remains unaffected on your computer.

Select an image.

Click [Print & Share] and then select [Create Image

for Email] in the menu that appears.

Select [Using the recommended settings.] and then

click the [Finish] button.
Create Image for Email window

Create image for Email

. & 3

WCE Print && Share Send to Trash
| Photo Print...
@, [ seecurgmages + | 2 3 = B index Print

-~
Print && Share Send to Trash

ut Print
Create Image for Email...
pload movies to YouTube...

0. of Images

Image Settings

(@ Using the recommended senings.)

O Using custom settings.

» Confirm Current

It is recommended that
the total file size of
attachments be limited
to 1 ME or less.

To reduce file size, carry
out one of the
operations below.

-Reduce the number of
images selected.

—Click the [Custom
Settings...] button and
adjust settings.

Cancel

) (€ Finish )

The [Create Image for Email] window appears.

The image is displayed in the main window and the e-mail

software starts up.

© Attach to the e-mail [Email Images] in the folder area and then

send the e-maiil.
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Creating Wallpaper from an Image

You can make a selected image wallpaper for your computer.
The JPEG image for the wallpaper (extension “.JPG") is created using a
copy of an image and therefore the original image remains unaffected.

Select an image.

Select the [File] menu P [Export Image].

File

Close ®W

New Folder N
Favorite Folders >

Copy Image...

Move Image...

Duplicate H
Rename...

Send to Trash @

Search... 3BF

Export Image... )
Ld
Process RAW Images by Digital Photo Professional...

Connect to Camera...
Rewrite Image to Memory Card...

Print »

Sound

The [Write a still image] window appears.

Select [Export an Image as Wallpaper] and then click

the [Next] button.
Write a still image window

o

Write a still image

@ Edit and Save Image

Converts images to a different image type or changes the size.
Movie images or RAW images cannot be exported.

() Export Shooting Properties
Exports the Shooting properties of the selected image to a file.

s
(_ Export as a Screensaver

Creates a screen saver from the image.
Maovie images and RAW images cannot be exported.

(O Export an Image as Wallpaper]

The image will be made so you can use it as Wallpaper.
Maovie images and RAW images cannot be used as Wallpaper.

r\. s J

The [Set Image as Wallpaper] window appears.

From the list box, select the wallpaper display

method and then click the [Finish] button.
Set Image as Wallpaper window

Set Image as Wallpaper

Sets the image as Wallpaper

Specify Display Method [ Fit to Screen | :!)

cancel ) ( <Back )| Finish—)

The image you selected for your wallpaper is applied as

wallpaper.
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? To revert to the original wallpaper

On the desktop, launch [System Preferences] from the Dock and then
click [Desktop & Screen Saver].

Select the [Desktop] tab sheet.

Select the file for the wallpaper and then click [ €3 ] to close the dialog
box.

Creating a Screen Saver from an Image

You can make a selected image a screen saver for your computer.
The data for the screen saver (extension “.SLIDESAVER”) is created
using a copy of an image and therefore the original image remains

unaffected.

Select an image.

Select the [File] menu P [Export Image].

File

Close

New Folder
Favorite Folders

Get Info...

Copy Image...
Move Image...
Duplicate
Rename...
Send to Trash

Search...

HBW

2@

®8F

Export Image...
IZe 1Mdge

Print

Sound

Process RAW Images by Digital Photo Professional...

Connect to Camera...
Rewrite Image to Memory Card...

)

The [Write a still image] window appears.
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Select [Export as a Screensaver] and then click the

[Next] button.
The [Export as a Screensaver] window appears.

Using the keyboard, enter a name and then click the

[Finish] button.
Export as a Screensaver window
Export as a Screensaver

-
eee
The selected image will be exported as a screen saver.

Name of Screen Saver

IB_ScreenSavers

Save To
Macintosh HD:Users:canon:Library:Screen Savers
( Cancel ) ( <Back )|( Finish ?}
4
The screen saver data is saved in the [Screen Savers] folder.

Specify the saved screen saver on your computer.
On the desktop, launch [System Preferences] from the Dock and
then click [Desktop & Screen Saver] P> [Screen Saver] tab sheet

to display the [Screen Saver] tab sheet.

Desktop & Screen Saver
Q

880

Screen Savers

[Ty Tures

Show All
Desktop | Screen Saver } —

Preview

P iunes Artwork
’a Nature Patterns
fa Paper Shadow
A RSS Visualizer
A Spectrum

@ -Mac

[l Pictures Folder
e

lj Choose Folder.
Test )

(_ Options... ) (

Q IB_ScreenSavers

" Use randofm screen saver

\] 1 1 1 1
30 1hr Zhr Never

aver:
| |
5 15

Start screen s

[ HotCorners... )

'
3

Select the saved screen saver data

Close the [Desktop & Screen Saver] window.

Click [ #% ] on the top left of the dialog box.

)
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Printing Multiple Images on One Sheet of Paper (Index Printing)

Specify settings such as the paper type and the

You can arrange multiple images in index format and print them on one

sheet of paper.

Select the images.

Click the [Print & Share] button and then select
[Index Print] from the menu that appears.

Q| Selecting images EI 3 =

-
WCE
f

Print && Share Send to Trash

Photo Print...

0. of Images

=.

Print && Share

Send to Trash

1 index Print... )P
YOUL Print...

Create Image for Email...
Upload movies to YouTube...

The [Index Print] window appears.

)

Introduction

number of prints, and then click the [Print] button. Table of
Index Print window Contents
rB ]S Index Print ]
:imerr Preview Basic
ame: .
: Operation
[ Canon Xxx F
| Page setup...
:aper size : AdV ed
4 a
— . Op ion
Orientation: Portrait
On printers that support borderless
printing, this feature is not
recommended.Click [Page Setup] to o
change this satting. ng h-Level
= Functions
Copies: i A 4] 2’
Page Layout Settings —
— e
Rows e Preferences
Columns: 2 g
Page Caption Settings —— > . f;\
™ Shooting Information GE ot ik o, .
Settings... ) = = USIng the
| | R
[ Header / Footer 5 § —ilf Internet
Rotate Left Rotatie Right Trim Image
Settings..
( Close )'(: Print )'
- Reference
Print preview
Printing begins. COlTETE
Lookup
Index

@ For a list of index print window functions, refer to p.83.

QO
O
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Arranging Images Freely and Printing (Layout Printing)

You can lay out images freely and then print them.

Select the images.

Click the [Print & Share] button and then select
[Layout Print] from the menu that appears.

@,| Selecting images |E‘ 3 =
. '

Print && Share

Send to Trash

The [Layout Print] window appears.

. & g
\GE Print && Share Send to Trash
3
Photo Print...
1 noe Drin
Layout Print...

reate Image for Email...
Upload movies to YouTuba...

0. of Images

Lay out your images by dragging them and then click

the [Print] button.
Layout Print window

(@06

Layout Print

Print Style

Preview

| Custom layout printing

=

Name:

Printer =

| Canon Xxx

( Page setup...

=
)

Paper size :
A4

Orientation: Portrait

Click [Page Setup] to enable
borderless printing on supported
printers.

=

Rotate Left

R | = 4 =

Rotafe Right Trim Image Images
per Page

Re-Layout Clear

( Close ) ( Save I( Print

)]é

Printing begins.

Print preview

@ For a list of layout print window functions, refer to p.84.

)
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3 High-Level Functions

EER

i

Comparing Multiple Images.........c..cccevvvviivievveennnnnn. 51
Viewing Shooting Information for an Image............. 52
Changing the Size and Type of an Image and
SAVING ot 52
Exporting Shooting Information ..............ccccceeeeeeees 53
Extracting Still Images from a Movie ....................... 54
Organizing Images Using High-Level Functions ..... 56
Setting Keywords in Images.........ccovvveiiiieeiieeeiiiinnnnnn. 56
Entering Comments into IMages ............cceeevveeeeeeeennnns 56
Saving Multiple Images with New File Names............ o7
Classifying Images by Shot Date............ccccvvvvvvvvnnnnnes o7
Searching for Images .......cccoovvvviiiiiiveeiccie e, 59
Performing Advanced Editing..............cccevviiiieennnnn. 60
Adjusting the Color of an Image in RGB.................... 60
Adjusting the Brightness Level ...........ccccoveviiiiiinnennn. 61
Adjusting the Tone CUurve........cccccceeeeeeeeiveeeiiiceee e 61
Transferring Images to Other Image Editing Software... 62
Merging Images to Create Panorama Images............ 63
Adding Sound to Images/Playing Back ................... 64
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Comparing Multiple Images

To compare multiple images, you can split the viewer window into two,
three or four and display multiple images at the same time.
You can also align the display position of enlarged images and compare.

Click [Synchronize] and then enlarge the image.

In the main window, select the images you want to
compare (p.10).

Click [ /] (View Image) (p.78).
The viewer window appears.

Click [Number of Displays] and select the number of
iImages you want to display at the same time.

s , ¥ Single View
2-Page View (Arrange horizontally)
2-Page View (Arrange vertically)

T — T UL R VY - 3-Page View
ko window |'~.'3 AN A A SN < d A-Page View
& .

8. E. | & = ks

Edit Mumber of Displays §Synchronize Full Screen

b =1

Number of Displays Synchronize Full Screen

i

! " Fit to window Hj),:,r AR SRR 4
=. [ & = = i

er of Displays § Synchronize Full Screen Print Show
Information

[ Disnlav 10

Click Select the display magnification

Fit 10 windaw B roalr.

The viewer window is split and the multiple images are displayed
at the same time.

v

Example of display when [4-Page View] is selected

ane LS patures.
IMC_0101JPG (1/4)

IMC_0102 JPG (2/4)

IMG_0103JPG (3(4}
pem———

MGC_0103JPC (378

e 140 0 200 e 248

The synchronize display appears and all the images are displayed
at the same display magnification and in the same position.

The navigator window that displays the enlargement display
position appears and you can check and move the enlargement
display position (p.19).

Click [Synchronize] again to cancel the synchronize display. You
can now change the display magnification and move the
enlargement display position for each image.

To return to full view, select [Fit to window] from the list box under
each image.

To cancel the split display, click [Number of Displays] at the bottom of
the window and then select [Single View] from the menu that appears.

)
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Viewing Shooting Information for an Image
Display List Mode (p.78).

Select the image for which you want to view the

Changing the Size and Type of an Image and Saving

You can change the size of an image or convert it to a TIFF image
(extension “.TIFF") or a PICT image (extension “.PCT”) and save it.
Because the image is saved as a separate image, the original image
remains unaffected.

information.

Select the [File] menu P [Get Info].
The [File Information] window appears.

Click the [Advanced View] button.

( )

v

8ense File Information w

¥ Rating

,,,,,

¥ Keyward

( View/Modify Keywords...

¥ Brightness Histogram

Hide Detail
File Name: IMG_0001 ]
Madified: KRR SYHRR KHRK KK
File Size 7 MB (7,353,855 Bytes)
Image Size: e ¥ Shooting Information
Data Type: JPG
Item Name value
Seund: File IME_0001 JRE
Lock: = c del  Canon EOS XXX
-t ate/ Tim XX /XK/XX XX XXX
= ) 1/500
< Back ) { Next> ) Avi Aperture Value 5.6

|§| In Preview Mode, the same information as the [File Information]
window is displayed on the information display area (p.77).

Select an image.

Select the [File] menu P [Export Image].
The [Write a still image] window appears.

Select [Edit and Save Image] and then click the

[Next] button.

Write a still image

(8 Edit and Save Image)

Converts images to a different image type or changes the size.
Movie images or RAW images cannot be exported.

) Export Shooting Properties
Exports the Shooting properties of the selected image to a file.

=
(_ Export as a Screensaver

Creates a screen saver from the image.
Movie images and RAW images cannot be exported.

() Export an Image as Wallpaper

The image will be made so you can use it as Wallpaper.
Movie images and RAW images cannot be used as Wallpaper.

The [Edit and Save Image] window appears.
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Specify the image size, type, file name and save
destination, and then click the [Finish] button.

( Edit and Save Image

"I Resize the image

=) Specify the length dimension

[_] Change the image type

nage type IPEG
Image Quality Low /\_/‘ High

] Rename the file

Initial text

NEW Seguence number is assigned automatically

Example: NEW0OOL1.)PG
Original file size:27.5 MB
File size after compression: |" Calculation /\ ( Preview ‘/‘u
Save To:MacOSX:Users:canon:Pictures:xxxx_xx_xx:xxxx_xx_01 Browse... )

( Cancel ) | < Back ) ( Finish )

The image is saved as an image separate from the original

image.

Exporting Shooting Information

You can export as a text file the shooting information recorded to the
image.

Select an image.

Select the [File] menu P> [Export Image].
The [Write a still image] window appears.

Select [Export Shooting Properties] and then click
the [Next] button.
The [Export Shooting Properties] window appears.

Specify the export shooting information, the file
name, and the save destination, and then click the
[Finish] button.

Export Shooting Properties

T, N S

Select the image info to be written.
Creates a text file in which item names and values are tab-delimited.

"] Eile Name @
| Camera Model
|| Shooting Date/Time

|_| Shooting Mode

[ Lighting or Scene

|_| Ambience

| Effect

|| Photo Effect Mode

| Tw( Shutter Speed ) 3
|_| Av( Aperture Value ) v

Do an

(

./ ] .'/ \.

Select All Deselect All

File Name
Save To: Macintosh HD: xxixsoo_xx_01 Browse... 2

A single file is created for 10 images.
The file name is given a sequence number.

Y ' .
Cancel ) |\ < Back ) Finish

The shooting information is saved as a text file (extension
“TXT").

Introduction

Table of
Contents

Basic
Operation

Advanced
Operation

Preferences

Using the
Internet

Reference

Contents
Lookup

Index

-

QO
O

53



Extracting Still Images from a Movie

You can extract still images from a movie and save them as image files.

® When extracting still images from 1920 x 1080 MOV movies, a
temporary file is created for editing and it may take some time

before you can extract still images.

Select the movie.

...... BT, —— A A G, e—

Select the [Edit] menu P [Extrac
| Edit |

Select All A
Deselect All

Rotate Image...
Rotate According to Rotation Information

Flel]

Movie Edit...

Edit EOS Video snapshot...

I Extract frames from a movie... )
PhotoStitch...
Edit with Registered Application >
Keyword »
Change Rating 2
Special Characters... NET

The [Settings] tab sheet for [MovieFrame Task] appears.

t frames from a movie].

Set the extraction method and click the [Preview] tab
sheet.

(@O0 MovieFrame Task 1

\Sel the Extraction Method.
1. Select how you want to extract still images from a movie.

"“‘ 2. Click the [2. Preview] tab and move on to the next step.

%

Select movie

) Extract all frames

% Extracts every frame in the mavie as a still image.

) Specify an interval and extract frames

[%; Specifies the interval at which still images are extracted from the movie.

File Name:MVI_5471.MOV ) Specify the number of copies and extract frames

Play Time'00:18.26 e i S %
Total Frames 548 e Specifies the number of copies of still images to be extracted fram the movie.
3

Image Size
Copies

‘ ) Extract a specified image

-+
% Extracts the frame you select while watching a preview of the movie as a still image.
i

L

@ [Extract all frames]
This option extracts all the frames in a movie as still images.
[Specify an interval and extract frames]
This option extracts still images from a movie at intervals of a set
number of frames or seconds.
[Specify the number of copies and extract frames]
This option extracts a specified number of still images from the
frames of a movie. The interval at which each of the specified
number of images is extracted is calculated evenly across the
movie's number of frames.
[Extract a specified image]
This option extracts a still image of a scene of your choice during
movie playback.
The [Preview] tab sheet appears.

)
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Check the extracted images and click the [Save] tab

sheet.
When [Extract a specified image] is selected in step 3, you can
play the movie on the left of the window and extract an image by
clicking [ ] when you reach a scene you like.

Rotate all the images
Add/remove all the check marks
Resize the thumbnails

~

8 06 MovieFrame Tajk

review images.
. Confirm the images to be saved. Images that arg checked will be saved.
. Click the [3. Save] tab and move on to the next gtep.

1 e 2_

%v ¥ v e Y
Wi 55| & — Ol @
Check all Clear all )| Clear previous Clear next

Rotate Thumbnail size

: i ¥
' [l —r L] '
File Narme MVl 5474.MOV

Play Time:01:00.00
Total Frames: 1800
Image Size:

Remove the check mark from the images
before and after the selected image

Playback/pause, frame back,
frame forward, half-speed
playback, double-speed playback

Save the images with
check marks

The [Save] tab sheet appears.

)

Introduction
Click [Save] and specify the required settings
(destination, etc.) in the window that appears. Then Table of
click [Choose]. Contents
’6 06 MovieFrame Task |
\Save still images. . ( ] )
; 3?;3’2!\20;;:\/'0&? gj&;;h:ulyxig::t(;:itiﬁ\gfﬂda.qe(s] from the movie and save. BaSIC
Operation
2. Preview
[ Advanced
Sove ‘ © Operation

Saved images: 548
Required Disk Space: Approx. 328.4 MB

File name:

@ Use original movie file name
() Specify a file name

& N
| . Example: MVI_5471_0001jpg
File Name:MVI_5471.MOV
Play Time:00:18.26 Auta folder creation:
mage SITH @ Automatically create a folder with the same name as the ariginal movie

() specify folder name

Total Frames:548 ’

AJ

=» Still image extraction begins.

Select the [MovieFrame Task] menu P [Quit
MovieFrame Task].
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Organizing Images Using High-Level Functions

You can organize images using high-level functions such as setting
keywords and entering comments, renaming multiple files in a single
operation and classifying images by shot year/month/date, all of which
are useful when organizing your images.

Setting Keywords in Images

You can set keywords to identify images. The set keywords are also
useful when searching for images (p.59).

Select an image.

Select the [Edit] menu P [Keyword] P> [Settings].
The [Keywords Setting] window appears.

Select the keyword(s) and then click the [OK] button.

8860

Keywords Setting

People

Places

Events

Others

; Family
L children
! Friends

! Home
L1 Beach

I city

; Party
::‘ Holiday
! Birthday

press the [+] button.

Check or uncheck the boxes to change the way Keywords are applied to the selected images. To
add a new Keyword to the system, type the name in the text field below the desired category, and

The keyword is set in the image.

Entering Comments into Images

You can enter information relating to images as comments. The entered
comments are also useful when searching for images (p.59).

Display the [File Information] window (p.52).

Click the [Advanced View] button.
A field for entering comments is displayed.

Enter text and then press the <return > key on the
keyboard.

8m06 __ File Information ]

¥ Keyward

( View/Modify Keywords...

¥ Brightness Histagram

Hide Detail
File Name: IMG_0001 ]
Modified: POKLHRXRKK MK
File Size 7 MB (7,353,855 Byres) D
Image Size: il W Shooting Information
Data Type IPG
E w

Walue
Sound: File N; IMG_D00 1 JFG
Lok — anon EOS XXK
— M XK 0K XK XK XK KK

< Back ) ([ Next>

The entered text is saved in the image.

Introduction

Table of
Contents

Basic
Operation

Advanced
Operation

Preferences

Using the
Internet

Reference

Contents
Lookup

Index




Introduction
Saving Multiple Images with New File Names Classifying Images by Shot Date
You can copy multiple images and save them with new file names in a Multiple images can be classified into different folders according to shot CTS‘r?t'gn"tfs
single operation. date.
Select all the images you want to save with new file Select all the images to be classified (p.10). Basic
names (p.10). Operation
Select the [File] menu P [Organize Image] P Select the [File] menu P [Organize Image] P [Sort
Images]. Advanced
[Rename]. : Operation
The [Rename] window appears. The [Sort Images] window appears.

Enter the file name and click the [OK] button.

s ™

Select [The files will be separated into folders for

each shooting date.] and then click the [Next] button.

Rename
Sort Images
Select the post-conversion file name type.
Select the sort method for the selected image's folder.
™ Copy Image Preferences
[8 The files will be separated into folders for each shooting date. )
@ MNew Name + Mumber
— () The files will be organized by rating.
_) Shooting Date + Number Using the
N Internet
) Mew Name + Shooting Date + NMumber
C Shooting Date + New Name + Number
Reference
New Name: [ ] Cancel |
Number: : : :
The [Organize by Shooting Date] window appears. EaTEn S
Specify Number of Digits 3 = Lookup
Specify a Start Number 1
Example:
_001.xxX Index
(The same extension as the original is entered in xxx)

Images separate from the original images are saved with the new

names.

©



Specify the folder structure, the file names, and the
save destination, and then click the [OK] button.

-

Organize by Shooting Date

~

The files will be separated into folders for each shooting date.

Save To:

A new folder will be created in this folder.

MacOSX Users:canon:Pictures: xxxx_XX_XX:XX... | Browse... )

Sort Folder Settings:

Based on the following settings, a new folder is created, and
the images are sorted by each of their shooting dates.

Folder Name: ' YearMonthDate

New Name: v\

MacOSX:Users:canon: Pictures:

300K 0k oo xx_01:2006_12_12

Copy/Move Images Setting

® Copy

=
_ Move

k_ Cancel \,'I(_- < Back

Images are classified by shot date.

Setting Item

YearMonthDate

Year/YearMonthDate

Year/Month/
YearMonthDate

Year/NewName

NewName/
YearMonthDate

YearMonthDate/

NewName

Settings for Folder Structure

Description

Classifies images by creating a first-level folder
according to shot year/month/date.

Classifies images by creating a second-level
folder for the shot year, and the month and date.

Classifies images by creating a third-level folder
for the shot year, the month, and the date.

Classifies images by creating a new folder with a
new name inside the shot year folders.

Classifies images by creating folders for shot

year/month/date inside a folder with a new name.

Classifies images by creating a new folder with a
new name inside the shot year/month/date
folders.
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Searching for Images

You can search for images by ratings (p.19), shot date, comments (p.56)

and keywords (p.56).

Select the [File] menu P> [Search].
The [Set Search Criteria] window appears.

Specify the search criteria and then click the [Search

Now] button.

e (3] Set Search Criteria

Specify Search Folder:MacOSX:Users:canon:Pictures:oxoo_xx_01

Browse

@ Match all conditions C Match any conditions
»  [_|Rating

» [Date
> Keyword

» | Comment

___[H

v

Cancel (

Search Now - ]

The search begins and the images that match the criteria are

displayed in the [Search Results] window.

Click the [Finish] button to close the [Search

Results] window.

The display returns to the main window.

Check the searched images in the main window.
The searched images are displayed in the main window. Also,
the [Search Results] folder is displayed in the folder area, and by
selecting this folder, you can display the searched images at any
time.

S man

i Feldary
s Search kesules
Ptiines.
ary

L Mowes

———————————

ol i Sdacind W 7 Vet W g

The images inside the [Search Results] folder are stored until
you either perform another search or quit IB.

Any work you do on images inside the [Search Results] folder will
be applied to all the original images. Therefore, please be aware
that if you edit or delete images inside the [Search Results]
folders, the original images will be edited or deleted also.

)
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Performing Advanced Editing

This section explains image editing using high-level functions based on
the assumption that you are familiar with handling standard image
editing software.

JPEG images deteriorate slightly when edited and saved, and the image
before editing cannot be recovered. For this reason, an edited JPEG
image should be saved as a separate image from the original image.

|§| You can edit RAW images in Digital Photo Professional (hereinafter,
“DPP”). Select the RAW image in the Main Window and select the
[File] menu P [Process RAW Images by Digital Photo Professional],
which will start up DPP. For detailed instructions on using DPP, refer
to “Digital Photo Professional Instruction Manual” (PDF electronic
manual).

Adjusting the Color of an Image in RGB

You can adjust the color of an image in RGB (red, green, blue).

Display the image to edit in the viewer window (p.18).

Click [Edit] and then select [Color/Brightness

Adjustment] in the menu that appears (p.27).
The [Color/Brightness Adjustment] window appears.

Introduction
Select the [RGB Adjustment] tab sheet and adjust
the image. Table of
( Color/Brightness Adjustment CO ntents
@Ca\ar}\dﬂstmem !
Basic
Red %‘ =0 1 Operation
CREnEEENES a — 0—§
Advanced
ue = o O t
Bue w S peration
__! Show Original Image Undo All Undo
(| cancel ) H@Kv—)
Drag to the left or right to adjust ERR -
»The image is adjusted.
Check the adjustments and then click the [OK] Using the
button. Internet
+ Save the image as a separate image (p.28).
Reference
Contents
Lookup
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Adjusting the Brightness Level

You can adjust the level of brightness (balance).

Display the image to edit in the viewer window (p.18).

Click [Edit] and then select [Level Adjustment] in the

menu that appears (p.27).
The [Level Adjustment] window appears.

Adjust the image.

3888 x 2592 | |

Drag right to adjust Drag left to adjust

Drag to the left or right to adjust
The image is adjusted.

Check the adjustments and then click the [OK]
button.

Save as a separate image (p.28).

Adjusting the Tone Curve

)

Introduction

You can adjust the brightness, contrast and color of a specific area by ggﬁt'gn"tfs
changing the tone curve.
Display the image to edit in the viewer window (p.18). Basic
Operation
Click [Edit] and then select [Tone Curve Adjustment]
in the menu that appears (p.27). Advanced
Operation

The [Tone Curve Adjustment] window appears.

Adjust the image.

Tone Curve Adjustment

. Input: o

Qutput: (

Use Last Appfied Settings

Show Original Image Undo All Undoe

( Cancel -

3888 x 2592 | [

Click to add a [ H ] (point)
Adjust by dragging [l ]

The image is adjusted.

The horizontal axis shows the input level and the vertical axis
shows the output level.

The maximum number of [l ] is 10.

To delete a [H ], press the < delete > key on the keyboard.
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Introduction

Check the adjustments and then click the [OK]

Transferring Images to Other Image Editing Software

button. . . . Table of
You can transfer images to image editing software other than IB. Contents
Save as a separate image (p.28).
In the main window, select the [ImageBrowser] menu
» [Preferences]. Basic
. Operation
The [Preferences] window appears.
From the menu, select [Register Application] and Ad d
then click the [Add] button. Operation

The [Application Selection] window appears.

Select the image editing software to transfer to, and HigMevel
then click the [Open] button Fugns
The selected software is registered.
A Click the [OK] button and then close the
. Preferences
[Preferences] window.
~ Select the image you want to transfer to the image
it Using the
editing software. ey
Select the [Edit] menu P> [Edit with Registered
““ Application] P> image editing software to transfer to.
The selected image editing software starts up and then image is Reference
displayed.
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Merging Images to Create Panorama Images

You can merge up to four JPEG images to create panorama images.

For merging images, start up the image-merging software “PhotoStitch”

from IB and use.

1 Select multiple images to merge (p.10).

2 Select the [Edit] menu P [PhotoStitch].
=» PhotoStitch starts up and the main window appeatrs.

Check the arrangement of the images to be merged

and click the [2. Merge] tab sheet.
@ If the arrangement of the images to be merged is not correct,

drag the images to rearrange them.

(@06

PhotoStitch

1. Selection and Arrangement

Merge Images Shot in Stitch Assist Mode

Click [2. Merge] to merge these images.
For images shot as a 360-degree panorama, click [Arrange], select
[350 Degrees] and then click [2. Merge].

2. Merge

Enlarge

STITCHO1.JPG

STITCHOZ.1PG

STITCHO3.JPG

STITCHO4.1PG

No. of Images: 4

1024 3 762 True Colar

Al

=» The window switches to the [2. Merge] tab sheet.

4

Click [Start] to merge.

@06 PhotoStitch

Merge Images
Click [Start] to begin merging.

(+)

Enlarge

STITCHO1.JPG | STTCHOZJPG | STITCHO3.PG

STITCHO4.1PG

alrl

Mo. of Images: 4 Panning (Scenery, ete.)

Focal Length: Auto Acquire - Canon |

=» The images are merged and displayed.

Click the [3. Save] tab sheet.

=» The display switches to the [3. Save] tab sheet.

G
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|§| See also the Help that are displayed when you click [

Adding Sound to Images/Playing Back

You can add sound to images and play back sound which you have
added to images with a camera that has a sound record function.

Check the save range and then click [Save].
(606

Photostitch ]

Save Image
Click [Save] to save the merged image. To merge a different image,
return to [1. Selection and Arrangement], click [Clear] and then [Clear
Alll.

Adding Sound to Images
You can add a sound file to an image.
A Mac OS X function is used for sound recording. When inputting sound
from external equipment, connect the external equipment to your

computer beforehand.

(+)

Adjust Image.. Enlarge

Select an image to which you want to add sound.

Select the [File] menu P [Sound] P [Record].
The audio recording dialog box appears.

» Click [ @] (recording button) and begin recording the
sound to be added to the image. Click the [Save]

button to stop recording.
=» The recorded sound file is added to the image. The [E,EI ]iconis
displayed in the image to which the sound file was added.

Irnage Size : ZEST x 734 A

Save range
Drag [ M ] to change the range

The [Save As] dialog box appears.

Specify the save destination and then click the

[Save] button.
The merged images are saved.

Playing Back Sound

You can play back sound files that are attached to images.

)
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Select the [PhotoStitch] menu P [Quit PhotoStitch].

PhotoStitch quits. Select an image to which a[[J{] icon is attached.

Select the [File] menu P [Sound] P> [Play].
The sound is played back.

] on the
right of the window for information on operating PhotoStitch and
PhotoStitch functions.
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Introduction
Preferences
You can change any of the IB functions in the preferences window. : :
Check the settings displayed for each window before making changes. Browser Window Setti ngs Table of
You can change the background color of the main window (browser Contents
Select the [ImageBrowser] menu [ 2 [Preferences]. window) as well as the color of the thumbnail image frames.
You can also make settings for color management.
. Basic
F_rom the menu, select th_e dialog box you_want to ) S . Operation
display, specify your settings, and then click the — —
[OK] button. Coler Scheme
& e M) Thumbnail Area Preview Area édvantqed
= - Frame Color [— Background Color [— pera jen
(Browserw‘mdow L. ]) Selection Color :l
Sl Background Color I:l
Thumbnail Area Preview Area ngh‘LeVeI
Frame Color [ Background Color — Customlcon & & 0 Functions
Selection Color " Create Custom lcon for Images
=

Background Color Color Management

|_| Adjust Image Colars Using a Monitar Profile

Custom lcon ® P f
I Create Custom lcon for Images = re ces

Calne Management - -
{ Cancel ) ( oK )

"1 Adjust Image Colors Using a Monitor Profile

@ Using the
Internet

f Cancel /Jf oK )
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Introduction
Viewer Window Settings Confirmation Dialog Box Settings
A . . . . . . . . . Table of
You can set the shooting information displayed in the viewer window You can set the software so that confirmation dialog boxes displayed Contents
(p.79). after each operation are not displayed.
The items you uncheck are not displayed.
Preferences BaS | C
| Viewer Window e ] Preferences OperatIO i
Select the shooting information you want to be displayed in the Viewer Window. (Confirmation Dialog Box 18 ]
E S;?n:f::cdel m Display a message dialog box in the following cases Advan Ced
"] shooting Date/Time Operatio n
# shooting Mode ™ When placing a folder in the trash
; Lighting or:5cene MWhen a search results folder is displayed
[ | Ambience
[ Effect ™ When filter settings have been changed : _
[_] Photo Effect Mode ) ) " L ’ ngh L_evel
¥ T( Shutter Speed ) ¥ When playing a movie containing rotation information Fu nctions
E‘ Av( Aperture Value ) "
"] Metering Mode v
Select All . Deselect All )
Pref ces
( cancel ) ( oK 3

Cancel ) ( 0K )
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? To display the shooting information in the viewer window @ @
In the viewer window, click the [Show Shooting Information] button @
(p.79) and in the menu that appears, select [Show Shooting Information]

to display the shooting information. 67



Processing When Rotating Settings

You can make settings related to image rotation.

Preferences

[ Processing When Rotating [+

Rotation process when a JPEG image is downloaded from a camera
"} Rotate an original JPEG image

A JPEG image that was rotated in the camera contains rotation information in the shooting
information.

However, if an image has original decision data appended, the actual image will not be
rotated.

( Cancel ) ( 0K

Layout Print Settings

You can make settings for layout printing.

Preferences

| Layout Print H

Item to print in caption

|_| Shooting Date
O Shooting Time

I File Name

Length

"inch |3]

\ Cancel /l 6

Photo Print Settings

When printing with the [Photo Print] window (p.16), you can set whether
to trim the image and print with no borders around the paper, or to print

as is without trimming.

Preferences

| Photo Print H

Trimming Settings

® Automatically trim to remove extra white space

~ 2
_) Do not trim

\ Cancel )1 ( 0K

)

Register Application Settings

You can register other editing software.

Preferences

! Register Application [ ]

A registered application can be run using [Edit with Registered Application] in the [Edit]
menu.

Delete ) ( Add...

)

\ Cancel )1 ( 0K

)
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5 Using Images on the Internet introduction
Uploading a Movie to YouTube ............cccevvviieienenn, 70 S
Using CANON iIMAGE GATEWAY ......cccooiviviiiiiennn, 71 (GRS
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Uploading a Movie to YouTube

You can upload movies saved in your computer to YouTube.

Select a movie to upload in the main window.

Select the [Internet] menu P [Upload movies to
YouTube].
The [Upload Movies to YouTube ] window appears.

Select the movie from [List], enter the title and other
information, and click the [[& ] (Upload) button.
The [YouTube login] window appears.

Enter your YouTube username and password and
click the [Login] button.

Smooth operation is not guaranteed with regard to future
YouTube specifications or specification changes.

Uploadable movies can be up to 10 minutes long and have a file
size of up to 1 GB.

You cannot upload movies that you have edited on your computer
(except Video Snapshot Albums).

An environment enabling Internet access (subscription with a
provider as well as installed browser software, an in-place line
connection, etc.) is required.

Provider connection fees and transmission fees to provider
access points are incurred separately.
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Using CANON IMAGE GATEWAY

CANON iIMAGE GATEWAY is a free Internet online service restricted to
users who have purchased a Canon digital camera (no membership or
annual fee).

To connect to CANON iIMAGE GATEWAY, it is necessary to register as a
member beforehand. Insert the EOS DIGITAL Solution Disk provided
into your computer and perform registration in the CANON iMAGE
GATEWAY member registration window that appears after installing the
software that includes IB. You can also use the following procedure to
register as a member.

For detailed information on CANON iMAGE GATEWAY, refer to the
CANON iIMAGE GATEWAY Help.

® To use this function, an environment enabling Internet access
(subscription with a provider as well as installed browser software,
an in-place line connection, etc.) is required.

Membership Registration

You can register as a member of CANON iMAGE GATEWAY.
When you have finished registering, you can also change the
connection information or add cameras.

Register as a member.
Click [CANON iIMAGE GATEWAY] and in the menu that appears,
select [Register/Add Product].

Register/Add Product

Top Page

a @ - = 3= Upload Images 13 =
A A Ty View Online Photo Album

?) B, @ .

CANCN IMAGE Print && Share Send to Trash CANON IMAGE Print && Share Send to Trash
GATEWAY GATEWAY

The [Register/Add Product] dialog box appears.

Click the [Register] button.
The browser software starts up and the CANON IMAGE
GATEWAY membership registration page is displayed.
Perform membership registration by following the on-screen
instructions.
When you have finished registering, you can also change the
connection information or add cameras.

Displaying the Top Page of CANON iIMAGE GATEWAY

The CANON iIMAGE GATEWAY top page is displayed with the browser

software.

Connect to the top page.

©® Click [CANON iMAGE GATEWAY] and in the menu that appears,
select [Top Page].

Register/Add Product
Top Page

QA @ Upload Images 13
R View Online Photo Album )

2.) 2. & (———

[CANON IMAGE Print && Share Send to Trash CANON IMAGE Print && Share Send to Trash
CATEWAY GATEWAY

Selecting Images EI :'_)—I -

The [Enter registration information.] dialog box appears.

Enter your user name and password and then click
the [OK] button.
When the connection dialog box is displayed and connection is
completed, the browser software starts up and the top page of
CANON iIMAGE GATEWAY is displayed.
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Introduction
Uploading Images in a CANON iMAGE GATEWAY Album Displaying a Registered CANON IMAGE GATEWAY Album bl of
You can upload images selected in IB in a CANON iIMAGE GATEWAY You can display images that have been uploaded in a CANON iMAGE Contents
Online photo album. You can also show images in a registered album to GATEWAY Online photo album with the browser software.
specified people. _
The images uploaded in an album are copies, so the original images Display an album. Opiarlzlt(i:on
remain unaffected on your computer. Click [CANON iMAGE GATEWAY] and in the menu that appears,
] ] select [View Online Photo Album].
Select images to be uploaded in an album. Advanced
Operation
Connect to CANON iMAGE GATEWAY. e
Click [CANON iMAGE GATEWAY] and in the menu that appears, L s a N, EEE Upload Images 13 s High-Level
select [Upload Images]. — @\ | (View Oniine Photo Album) Functions
Pril %hv 5 d§T h ¥ = P i‘;;Shv 5 dPT h
RS =» The [Enter registration information.] dialog box appears. Preferences
Top Page .
e Al e AN T ") Enter your user name and password and then click
- hd View Online Photo Album 2
@:mﬁ; PR it agcm,,; Rene SV ol =» When the connection dialog box is displayed and connection is L:ﬁltSthte
completed, the browser software starts up and the CANON S 4

Upload the images selected in step 1 to a new album

_ . ) IMAGE GATEWAY album page is displayed.
by following the on-screen instructions.
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Troubleshooting

If IB is not operating correctly, refer to the items below.
Also refer to the Help from the [Help] menu or click the [?] button at the
top of each window and refer to the Help displayed.

Installation could not be completed correctly

You cannot install software unless you are logged into an account with
Administrator privileges. Log in again into an account with
Administrator privileges.

For how to log in and how to specify Administrator settings, refer to
the User’s Manual for the Macintosh computer or for Mac OS X.

IB does not work

IB does not operate correctly on a computer if its system
requirements are not met. Use IB on a computer with compatible
system requirements (p.76).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.76), if other applications are running at
the same time as IB, you may not have sufficient RAM (memory). Quit
any applications other than IB.

The software preferences file may be corrupted. Quit all applications
and follow the procedure below to delete the preferences file from the
[Preferences] folder before restarting IB.

In the hard disk drive where the system is saved, open the [Users]
folder P> folder of the logged in user P [Library] folder » [Preferences]
folder, and delete the preferences files below.

Preferences Description

Preferences file for the
ImageBrowser

com.canon.ImageBrowser.plist

com.canon.RAWImageTask.plist Preferences file for the RAW
Image Task

Preferences file for the
PhotoStitch

com.canon.PhotoStitch.plist

Images do not display properly

Images that are not supported by IB (p.76) do not display. There are
various types of JPEG and TIFF images, so JPEG images other than
Exif 2.2, 2.21 or 2.3 compatible images and TIFF images other than
Exif compatible images may not display properly.

With initial settings, the color of images that have been shot in Adobe
RGB appear weak. In this case, check the [Browser Window] window
in preferences and checkmark [Adjust Image Colors Using a Monitor
Profile] (p.66). Color management is performed and the color of the
image shot with an Adobe RGB setting and the image shot with an
sRGB setting are matched.
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1 1 1 Introduction
Deleting the Software (Uninstalling)
Quit gny applications before gnmstallmg the software. . . ® You cannot retrieve data that you have emptied into the Trash
To uninstall the software, log into the account used when installation and deleted, so be particularly careful when deleting data. Table of
was performed. _ You cannot install the software again if you have just moved the Contents
To prevent computer malfunctions, always restart your computer after [ImageBrowser] folder to the trash. Be sure to select the [Finder]
you have uninstalled the software. menu P [Empty Trash].
Basic
Display the folder in which the software is saved. B
Open the [Canon Utilities] folder.
E 3 Advanced
Operation
[ High-Level
e Functions
Preferences
t Using the
Internet
Drag the [ImageBrowser] folder to the Trash.
Select the [Finder] menu on the desktop P [Empty Reference
Trash].
The software is deleted.
Contents
Restart your computer. Lookup
Index

-
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System Requirements

Even though the following are recommended system requirements, not
all computer functions can be guaranteed.

oS Mac OS X 10.5t0 10.6

Computer | Macintosh with one of the above OS installed

CPU* Intel processor (Mac OS X 10.5 to 10.6)

RAM* Minimum 512MB (Mac OS X 10.5), Minimum 1GB (Mac
0OS X 10.6)

Display Resolution : 1024 x 768 or more

Colors : Thousands or more

This software program is not compatible with UFS (UNIX File System)
formatted disks.

* Use a Core 2 Duo 2.6GHz or higher CPU and 2GB or more RAM
when working with MOV movies. However, even if there is nothing
wrong with a movie file, it may drop frame and not play smoothly
during playback, depending on your computer specifications.

Introduction
Supported Images
Image type Extension
JPEG images shot with a Canon digital (-:rgrk])tlgnotfs
JPEG images | camera (Exif 2.2, 2.21 or 2.3- JPG, .JPEG
compatible JPEG images)
RAW images shot with a EOS DIGITAL .CR2 Basic
RAW images*!| camera excluding EOS D6000, EOS TIF Operation
D2000, EOS DCS1, EOS DCS3 .CRW
TIFF images | Exif-compatible TIFF images TIF, .TIFF
- - - Advanced
BMP images | Bitmap images .BMP Operation
PICT images | PICT images PICT
. MOV movies shot with a Canon digital .MOV High-Level
MOV movies camera .MOV + .THM*2 Functions
: AVI movies shot with a Canon digital 2
AVI movies Y. AVIE+ . THM
1 For RAW images, the JPEG embedded in the RAW image is =i e
displayed and printed instead of the actual RAW image. In some
cases, displayed and printed images may be grainy.
*2 A “ THM” file is a (thumbnail) file generated and saved together with a Using the
movie file when shooting movies with some of Canon digital cameras. e e
It has the same file name as the movie and includes shooting
information, etc. When you play on the camera a movie file that was
saved together with a “. THM” file, both the movie file and the “.THM” Reference
file are required.
Contents
Lookup
Index

-
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List of Main Window Functions introduction
Preview Mode Image display area
Table of
D 5= e Q Contents
MANO [ ] Browser Window
Images acquired from your camera { Preview Mode | List Mode |
can be accessed here. ¥ Basic Information ~
File Name: IMG_UU[H— BaSIC
e XK/ KAIXK Operation
Image Size: 3888 x 2592
Data Type: JPG
Sound:
Lock: [:! Ad d
[ Favorite Folders | All Folders | SR vange
[ Movies e Operation
vf_ﬁ’Pictures - -
L:_',-' iPhoto Library ¥ Comment
vid KRXX_XK_XX 1 i .
fﬂi Information display area High-Level
Li'xxxxixxim Functions
[0 axxx_xx_04
¥ Keyword o —_
{ View/Modify Keywords... )
1 » Brightness Histogram Preferences
Folder area*™ — ¥ Shooting Information
- ftem Name L Value
s i i
Shooting Date/Time 3000/ 0¢ 2002300 XX ¥i .
i clirs NG ) Using the
—— Thumbnail image Internet
display area*?
L Shows/hides the folder area
. Reference
. . —— Shows/hides the task buttons
Filter display _
(p 20) L IMG_0DD1JPC IMC_0002.JPG IMG_0003.JPG IMG_{1004.J [ ) ShOWS/hldeS the
. c- - | <> . . .
L _ information display area
1 View |¢? Filter Toal |(={)=. & ﬂ\J Selecting Images 'H % =1 % p y Contents
Enlarges/ = J ’ , Selects/deselects all the Looku
9 3 = @ 2. 2. 8§ - P
redUCGS the | Add... | ‘ RErnE | Canon Camera View Image slideShow cAgAUTNEJVI\::GE Print && Share send to Trash Images
thumbna” (( Mo. of Images Selected: 1 / Total: 16 images )il ——— Number of Selected |mages/
images (p.11 . . . i
ges (p.11) Starts up EOS Utility/Displays Deletes images and folders (p.25) Total number of images Index
Download images window o . .
0.7, p.9) 9 Prints images and creates images for e-mail (p.15, p.44, p.48, p.49)
Viewer window (p.79) Connects to the CANON iMAGE GATEWAY @ @

Slide show (p.43)

1 Images in folders selected here are displayed on the thumbnail image display area. @
2 Images selected here are displayed on the image display area. 77



List Mode

RAW image icon

Bracketing icon

Image display area

Audio recording icon

Shows/hides the folder area
Shows/hides the task buttons

Selects/deselects all the
images

Number of selected images/
Total number of images

Movie icon Video Snapshot icon
|
i % Im \geBrowser File Edit Vi 3 e
A0 .
gﬁ%?;&f';ﬁéiﬂ"wwmmeml—, e
R —
I Favorite Folders | All Folders -
(| Search Results )
[ movies ==
[ Photo -
vfﬁF’ictures
[ iPhoto Library MVI_0000 MOV MVI_D0O1_MOV IMG_0002.CR2
W8 w00 xx_xx
[0 s _xx_01
[ wxxx_xx_02
[0 wxxn_xx_03
[ o _xx_04
oy
IMC_0005 CR2 IMG_0006.CR2
[RAW] [RAW]
Folder area*
Protect icon = i
IMG_0010.CR2 IMG_0011.CR2 IMG_0012.CR2 IMG_0013.CR2 IMG_0014 CR2
RAW ma} P:]
Filter display P
(p.20) 3
- — J Vlew|¢? Filter Toal |[_€"f GL EL]‘ Selel:tlnlglmages ‘,|| ﬁ‘] =
e — aim
Enlarges/ ' ' ; = = ‘
Favarites Ui -
redUCGS the Remove Canoﬁmaﬂ Wiew Image SI\E{M CAM?A#:E Prm:%h:m Sendiﬁ[msh
thumbnail ( Ne. of Images Selected: 0 / Total l?lmagesh
images (p.11) Starts up EOS Utility/Displays Slide show Deletes images and folders (p.25)
Download images window 43 o . .
(0.7, p.9) g (p-43) Prints images and creates images for e-mail (p.15, p.44, p.48, p.49)

Viewer window (p.79)

Connects to the CANON iIMAGE GATEWAY

* Images in folders selected here are displayed on the image display area.
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List of Viewer Window Functions

Display magnification
(p.19)

(606

IMG_0001.JPG (1/16)

| Fit to window

Switches
between images

Y &
4 4 =3 N~ = = Im — ﬁ &
Back Next Save Edit Mumber of Displays Synchronize Full Screen — Print Show
Information
(Image Size: 3888 x 2592) | | ( Display: 19 96) 7

Displayed image size

Saves the images (p.28)

Display magnification
Photo print window (p.82)

Edits the images (p.27)

Full view display (p.12)

Split displays (p.51)

Synchronize (p.51)

Image display area

Rating (p.19)

Shows/hides the
shooting information
and AF point

(p.12, p.18)

)
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List of Cut Movie Window Functions s Introduction

enn Cut Movie Table of
= B Contents
—
— . Basic
Operation

Displays the movie

Advanced
Operation
Current position during movie play ——
. . N . High-Level
Plays the movie/Stops the movie : , g Previous frame Functions
Adjusts volume S == = ® S W -~ Nextframe
[0 » ————T b
Sets the start point for a movie cut —— q e p—————— Sets the end point for a movie cut Preferences
0:00.0/006.0
Set Time: 0:06.0
| Cancel 'J,I __SEwE Using the

| Internet

Saves a cut movie as a separate movie

Reference

Contents
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List of Video Snapshot Alboum Window Functions .9

Redoes edit

Undoes edit

Opens music file

Opens Video
Snapshot Album

Video Snapshot
selected in
Thumbnail area

Deletes Video
Snapshot from
Thumbnail area

Plays Video
Snapshot Album

Saves Video Snapshot Album

Displays detailed description

s

— 1M 83 9

0K OO0 0000 MOV

Original movie information

File Name

Path

File Size

Image Size

Frame Rate
Recording Time
Sampling Freguency
Sample Size
Shooting Mode

o
# Music File Information

| File Name
Path
File Size
3 Play Time
Sampling Freguency
\ Sample Size

Adjusts volume

Changes order of
Video Snapshots

e

0:00.0 /0200

Frames/second

X sec. movie

0

J1 | ANGELS.wav

Presently selected Video Snapshot

Thumbnail area

Movie information

Music file
information

Selects audio
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List of Photo Print Window Functions

Printer selection and settings

(@06

Photo Print

Printer

' Canon XXX 4

Page settings

Shot date and
time settings

t Page setup... )

Paper size :

Ad

Click [Page Setup] to enable
borderless printing on
supported printers.

Shooting Date/Time

7_’ None F:‘i

Properties...

Trims the image

Sl Remove unwanted regions
==r | of your photo.

Add some text to print
with this photo.

m@ Image: 1/1

el

1 ?j Total : 1 pages

€

Close ) (: Print ) .
A

Switches the printing image

Number of prints

Print preview

Inserts text

)
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List of Index Print Window Functions

Printer selection
and settings

Page settings

Print information
settings

(®@ 06

Index Print

Printer
Name:

_.( Canon XXX FH

-

Paper size :
Ad
Orientation: Portrait

On printers that support borderless
printing, this feature is not
recommended.Click [Page Setup] to
change this setting.

Copies: 1

(a0

( Page setup... :J‘

Page Layout Settings

Rows: 3

) (¥

N

Columns: Fi

(4

Page Caption Settings

Preview

: )
" .
# Shooting Information Page: 1/3 I\!_/J
|
- § =B =
[ 1 Header / Footer —_—
§ = Rotate Left Rotate Right Trim Image
Settings...
( Close :’J ( Print :’J

A

Switches the printing page

Rotates the image

Print preview

Trims the image

)
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List of Layout Print Window Functions

Sets the printing
style

Printer selection
and settings

Page settings

(@06

Layout Print

Print Style

—i Custom layout printing

7

Printer

MName:

' Canon XXX

( Page setup...

Paper size :
Ad

Orientation: Portrait

Click [Page Setup] to enable
borderless printing on supported
printers.

Preview

& =) &l n B2 K &
—_— = ESE]
Rotate Left Rotate Right Trim Image Images Re-Layout Clear
per Page
( Clpse ) Save ) l: Print )

— Print preview

Rotates the image

Trims the image

Number of images per page

Deletes an image
Reverts to the original condition

G
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Contents Lookup introduction
Downloading Images to Your Computer Image Editing JE—
Download images by connecting your camera and computer =>p.7 Use automatic adjustment = p.27 (-ngr?':gnotfs

Download images using a card reader ->p.8 Adjust brightness/darkness = p.29

Ima . Make colors more vivid = p.29 r

g1 Llnee g Trim parts of an image - p.29 Operation

Look through = p.10 Specify an aspect ratio that matches the size of
Enlarge and view = p.11, p.18 the paper on which an image is to be printed »p2d Advanced
Play a movie =»p.13 Make an image sharp - p.31 Operation
Play Video Snapshot Albums = p.39 Insert text = p.30
Check efficiently = p.21 Correct red-eye = p.32 5
Compare multiple images = p.51 Merge -» p.63
Check the shooting information such as shot - p.52 @ Edit movies ->p.34
date @ Cut a favorite scene from a movie - p.38 g
View as a slide show < p.4z » Extract still images from movies = p.54

Image Printing Edit Video Snapshot Albums - p.40 lJlﬁitg?ntgte
Print one image on one page = p.15 Utilizing Images
Arrange multiple images on one page and print =» p.48 Attach an image to an e-mail - p.44 Reference
Arrange images freely and print - p.49 Make into computer wallpaper - p.45

Organizing Images Make into a computer screen saver -» p.46
Sort by rating - .19 Upload a movie to YouTube = p.70 Lookup
Move to a different location - p.23 Use CANON IMAGE GATEWAY 2p7l
Move by entire folder to a different location ->p.24 Converting Images
Change the file name - p.24 Change the size - .52
Delete P25 Convert to a different type -» p.52 @ @
Classify by shot date -» p.57
Search = p.59 @
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Index
A
Adding SOUNd tO IMAJES.......uuuuirriiiiiiiiiiiiiietiierreerrerreeereerreereeee e 64
AdJUSE JPEG IMAQES .. . uuiiuueiinniiiiinniiiiieeieeieetneeeeeeeenseeeeeeeeeeeeeeeeeees 27,60
Adjusting (JPEG or TIFF IMage).........cuuvvvririieerieeiiieieeeeeeeeeereeeeeeen 27, 60
AdUSEING IN RGB ... 60
Adjusting the Brightness..........coooiiiiiiiiiiieieece e 29
Adjusting the Brightness Level ... 61
Adjusting the Saturation ...................cc i, 29
Adjusting the Sharpness ......c..ocoovvivieiiiii e, 31
Adjusting the Tone CUIVe........ccoivviiiice e 61
Automatic AdJUSIMENt ... 27
COrrecting REU-EYE ......cooiiiiiiieeie e 32
Adjusting the Brightness ..........c.uuiiiiiiiiiiie e 29
Adjusting the Brightness Level...........ccccvviiciiii e 61
Adjusting the Saturation..............coeoeiiiiiiiii e 29
Adjusting the Sharpness..........ccceiiiiiiiic e, 31
Adjusting the ToNe CUIVE ..........ueeiiiiiiii e 61
Attach an Image to an E-malil.............ccccocuuviiiiiiiiiiiiiiiniiineiieeeeeseeeeeeeees. 44
AUtOMALIC AQJUSTMENT ....eiiiiiiiiiiiieiiee e 27
B
Batch Change the File Name of Images........cccccovviiiiiiiiiiiiiiiiiiei 57
Browser WIiNAOW .............uuueuuiiiiieriiiiiiiiiieeiieeiieeieeeeeeeeeeeeee —~>Main Window
Browser Window Settings (Preferences) ........ccccoooccvvieeeieeiiiiiiiinennenn. 66
C
CANON IMAGE GATEWALY ...ttt 71
Displaying an AlDUM ..........ccoooiiiiiii e 72
Membership Registration ............ccccoviiiiiiiiiiieiiieee e 71
Uploading Images in an Album ... 72
Change File NamMe ..o 24
Change Folder Name.........ccoov i e 24
Change the Display Magnification ............cccooocuiiiiiiieeiiiiiiiiieeeeeeee 11
Changing the Size and Type of an Image and Saving........................ 52
Checking the Shooting INformation...........ccccoeeiviiiiiee e 52
Classifying the Images by Shot Date...........ccccccccieieiii e, 57
COolor MaNAGEIMENT ...t e e 66
Compare Multiple Images ... 51

Confirmation Dialog Box Settings (Preferences) .........cccccvvevvvvcennnennn. 67
Correcting REA-BYE ......cooooeiiii i 32
Creating @ FOIAEN .......coo e e 22
CULtING 8 MOVIE....ciiiiiiiiieiii et 38
D
Delete
Delete FOIders. ... 25
Delete IMAGES .....viiiiiieiieiiei e 25
Delete the Software ..., 75
Delete FOIAEIS ....cooiiieeeee e 25
Delete IMAGES ...ttt e e eeeeeeas 25
Delete the Software (Uninstalling) ...........c.ccuuvvvvevviiiiiiiiiieiieeiieeeeeeeeeeeee, 75
Deleting the 1B (Uninstalling) ..........uuvveiiiiiiiiiieeeeeeeee e 75
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About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments
© Macintosh is a trademark of Apple Inc., registered in the United States

and other countries.
Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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